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BASLANGIC

Topcon Tools Topcon un kolay kullanima sahip gli¢li dengeleme yazilimidir.Topcon Tools kullanicinin
satin almis oldugu lisans modiillerine gére GPS RTK gozlemlerinin degerlendirilmesi , GPS statik olci
datalarinin degerlendirilmesi , Total Station , ve bunlarin degisik birlesimleri ile ¢oziimler lretecek
moddlleri icermektedir.

Baslangic diizeyinden gelismis islemleri gerceklestiren jeodeziciler Topcon Tools ile asagidaki islemleri
gerceklestirebilirler ;

e GPS bazlarinin post-proses i

Total station ve/veya RTK g6zlemlerinin prosesi

Ag dengelemesi

Bilgisayar ya da cihazdan dogrudan dosya alma

Bilgisayara ya da dogrudan cihaza dosya verme
Topcon Tools un asagidaki islemleri yapmak icin bilgi ve grafik ekranlari varir ;

e Bilgi ekranini kullanarak nokta bilgileri , vektér ya da gozlem bilgileri , ayni isme sahip
datalarin goérintilenmesi ve hatlarin alfabetik olarak ya da zamana gore artan ya da azalan
degerlerine bagl olarak siralamasi kolaylikla yapilabilmektedir.

Harita ekraninda genel kullanimdaki ag konfiglirasyonlari gorintilenebilir , noktalarin ya da
bazlarin hesaplanmis yaklasik pozisyonlari, secilen baz ya da noktalar icin goriintiilenebilir.

Gozlem ekrani gozlemlerin goriintilenmesi icin kullanihr.

CAD ekrani hat islemleri ve vylzeyler bagl olduklari nokta ya da hatlara bagh olarak
goruntilemek icin kullanihr.

e Tasarim ekrani dijital ylzey olusturmak, editlemek ve yol kesitleri ile ilgili olusturma ve
editleme islemleri, en kesit sablonlarinin olusturulmasi ve editlenmesi i¢in kullanilir.

imaging ekrani stero fotograflar ve tarama segenekleri igin kullanilir.

Harita ya da bilgi ekranlari arasinda gecisler olduk¢a kolay ve goriintileme bilgileri editleme islemleri
kullaniciya en kolay sekilde ¢alismayi sunmaktadir.



PROGRAM KURULUMLARI

e Topcon Tools un Kurulmasi

Size verilen kurulum CD si ile Topcon Tools ve ToplLink kurulumlari gergeklestirilir. Kurulum igin
kurulum dosyasi calistirildiginda kurulum sihirbazi ekrana gelir.ilk ekranda Next tiklanarak kurulum
siireci baslatilmis olur.ikinci ekranda Kullanici adi ve Firma bilgileri girildikten sonra Next tusuna
basilir. Programin default olarak kurulacag dizin ekrana gelir ve next tusuna basildiginda kurulum
devam eder. Eger arzu ediliyor ise Browse tusuna basilarak baska bir klasére programin kurulmasi
saglanir. Tavsiye edilen default klasére kurulmaya devam edilmesidir.
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Kurulum tamamlanma ekraninda Finish tusuna basilarak kurulum tamamlanmis olur. Programa
kolaylikla erisilebilmesi icin bilgisayarinizin masatstiine Topcon Tools kisa yol tusu otomatik olarak
eklenir.
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e Microsoft Activesync Kurulmasi ve Ayarlarinin Yapilmasi

Topcon kontrol (nitelerinden Topcon Tools igine data alinabilmesi icin bilgisayara Microsoft
Activesync oncelikle kurulmaldir. Activesync bilgisayar ile Topcon Kontrol {nitesi gibi tasinabilir
cihazlar ile bilgisayar arasinda baglantiyi saglamaktadir. Mobil cihaz Windows CE isletim sistemine
sahip olmalidir. Activesync yazilimi www.microsoft.com sitesinden en son versiyonu Tirkge olarak

Ucretsiz olarak indirilebilir. Paksoy tarafindan kullaniciya verilen Topcon GNSS isimli cd de bu kurulum
bulunmaktadir.

Kurulumu standart prosedirleri izleyerek gerceklestirin. Kurulum tamamlandiktan sonra
bilgisayarinizda Baslat,Programlar altindan Microsoft Activesync ikonunu tiklayarak programi
cahistirin. Ekrana Get Connected penceresi gelir.



Get Connected E|

Get Connected

To connect pour device to this PC:

1. Connect the cable to the PC
2. Tumn on he device

3. Place the device in its cradle

LetiveSync shoud automabically detect pour dewica.

If woun device iz nob ackomalically detected, click. Mext.
If oy are uzing infrared (1R, click Help.

Cancel Help

Next tusuna basin. Bagladiginiz kontrol (nitesi acik ise ve USB kablo ile ya da Bluetooth ile ya da
Ethernet ile bagl ise bilgisayar Kontrol tnitesi ile baglantiyi saglar ve Connected diyalog kutusu
ekrana gelir.

©) Microsoft ActiveSync

File ‘iew Tools Help

Details Explore Options

Connected @

Informakion Type Status

Saglikh bir sekilde baglanti saglandiginda sistem bar da yesil renkte Activesync ikonu belirir.



NOT: RTK 6lcu datalari Kontrol Unitesi icinde *.tsv uzantili olarak kaydolmaktadir. Bu dosyalar sadece
kontrol (nitesi icinde kurulu olan Topsurv yaziliminda agilabilir. Bu dosyalari kontrol {initesinden pc
ye alirken Topcon Tools ya da Toplink otomatik olarak *.tlsv dosyasina donistirilmektedir. Topcon
Tools ve Toplink yalnizca *.tlsv dosyalarini acabilmektedir.

@DMKAT: Verilerinizin kaybolmamasi ve Topcon Tools ve Toplink de agilabilmesi igin
mutlaka aktarim yaptiginiz bilgisayarda Microsoft Activesync ve Topcon Tools / Toplink kurulu
olmalidir. Eger kontrol (Unitesinde kullanmis oldugunuz Topsurv yazilim versiyonu Topcon
Tools/Toplink versiyonundan daha yeni ise donustirme ve dosya agma problemi ortaya ¢ikacaktir. En
son versiyon yazilimin bilgisayarinizda kurulu oldugunu kontrol edin.

Eger bilgisayarinizda sadece COM port mevcut ise ya da baglantiyi sadece COM port dan yapmak
istiyorsaniz :

1- Microsoft Activesync yazilimini ¢alistirin.
2- File->Connection Settings i tiklayin.

++ Microsoft ActiveSync
File View Tools Help

Symchranize

Stop

Maobile Device k
Explore

Delete Partnershio

et Connecked. ..

Conneckion Setkings...

Close

3- Asagidaki secimleri yapiniz.



Connection Settings

Q Click Get Connected ba connect your maobile device to thiz

i@ corputer.

Statuz: Device connected |

[v Allow serial cable or infrared connection tothis COM part

| [

Stats:  COM port iz avalable

v Allow USE cornection with this deskiop computzr,

Staisz;  Connected

v Allow network [Ethemet] and Femaote Access Service [FAS)
zerver conechon with thiz desktop computer.

Statiz  Metwark iz available

Statuz ican

[w Sk statuz icon n T askbar.

OE. Cancel Help

Bununla kontrol Gnitesi baglantisi kesildikten sonra tekrar COM port ile baglanti kurma isteginde
bulunmaz. Eger bilgisayarinizda birden fazla COM port mevcut ise COM1 yazan acllir listeden baglanti
icin kullanacaginiz COM numarasini seginiz. COM port bilgisayar ile TPS GPS+ alicilari ya da Total
stationlari ile baglanti kurmada kullanilir.



TOPCON TOOLS MODULLERI

Topcon Tools degisik ihtiyaclara gore siparis edilebilen moddler bir yapiya sahiptir.Asagidaki modiiller
mevcuttur.

Post Prosesing modiilii
GPS+ (GPS+GLONASS) datalarini proses motorunu iceren modulddr.
RTK Modiilii

Topsurv ile kaydedilmis olan RTK(Gercek zamanli kinematik) datalarinin program icine alinmasi ,
gorintilenmesi, disariya verilmesi, raporlanmasi islemleri gerceklestirilir.

TS Modiili

Total station ile kaydedilmis datalarin program icine alinmasi , goriintiilenmesi , disariya verilmesi ,
raporlanmasi islemleri gergeklestirilir.

GIS Modiilu

Daha az hassasiyetle kaydedilmis olan DGPS 6l¢l datalarinin sonradan degerlendirilmesinin yapildig
moduldir.

Dizayn Modiilii
Sayisal arazi modeli olusturulmasi ve editlenmesi ile ilgili kullanimi iceren moddldir.
imaging Modiilii

Taranmis gorintilerin , stero cekilmis fotograflarla ilgili calismalara ait islemlerin yapilabildigi
moddaldir.

Gelismis Modiilii

Proses ve dengeleme asamalari icin gelismis 6zellikleri iceren moddlddr.



TOPCON TOOLS A BASLARKEN

Kullanilan Topcon Tools modiiliine bagli olarak donanim kilidi ya da lisans kodu ile ¢alisilabilmektedir.
USB kilit ile calisiliyor ise USB kilidin PC de calisan isletim sistemi strtctsinin dncelikle kurulmasi
gerekmektedir. Bu siiriicl elinizde bulunmuyor ise Paksoy dan temin edebilirsiniz.

Lisans kodu ile galisiliyor ise Topcon dan satin almis oldugunuz modiilleri aktif hale getirecek lisans
kodu gelecektir. Bu kod un temini icin de Paksoy ile temasa geciniz.Lisans kodunu temin edebilmeniz
icin Topcon Tools calistiginda ekrana gelen “Enter Access Code” penceresindeki Key Value degerini
Paksoy a iletmeniz gerekmektedir.

Program calistig§inda asagidaki ekran gelecektir.

ﬁ Enter Access Code

Keu'alue |HEHC-BHIE-GHC)-HCCH
.-’-'-.veiIaE 2 mnau R

& e ! Cadamskabis

B 5323 FROTES-,., 0K PR, RTK, TS, GIS, Imaging
E=DDCR-B2808B5-, ., O Aad d

varee Add cade
b= DEFD-74636F-,,, Ok Cesign, Advanced

[elete code

Acozzs Code it avalable from Topeoon Sdes Support

I 3
Module

[FI=E, advanced
|'_|;| Design
[¥]:" s

& Inaging
& PP

& RTE
< 13

Cloze

Add code tusuna basilarak size Paksoy tarafindan verilmis olan lisans kodunu giriniz. Kod girildiginde
alt bélimde bulunan “Enabled Modules”penceresinde aktif olan modiiller gériintilenecektir.

Lisans kodu girilmeden Topcon Tools demo moda c¢alisabilmektedir. Demo moda program
calistirllacak ise “Enter Access Code” penceresinde Demo Mode ikonu tiklanir. Demo mod da bes
adet nokta goérintilenip proses edilebilir.
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Lisans kodu girildiginde ya da USB donanim kilidi bilgisayar USB portunda takili ise program ana
ekrani agilacaktir.

..-4 Tu-pcan Tools

& 2| @ | R

= Startup

Job name | Joblocation | Created | Lastaa|
& pdrst C\Progr.,. 17:27:24.,. 14149 _
& DDalt Ci\Progr... 17:27:24... 1353
@ Dlinformation Ci\Docu..,  08:47:09... 13:50
& DmTest C:\Docu.., 0%01:17... 1559
glmadng C\Docu...  15:13:32.,, 13:16
& ImagingTest Ci\Docu..,  16148:22.,, 16:03 %
< I

Ready [ | | o

Startup penceresi otomatik olarak ekrana gelecektir.Bu ekranda ister daha once calisilmis bir is
dosyasi agllir isterse yeni bir is dosyasi olusturulabilir.

Topcon Tools Ana ekrani ve Menii ekrani

Topcon Tools ana ekrani asagidaki elemanlardan olusur.
Men ¢ubugu : Asagi acilan yapida Topcon tools meniilerini iceren bolimdir
Arag cubugu : Sik kullanilan menilerin buton olarak bulundugu meni ¢ubugudur.

Durum Cubugu : Topcon Tools un mesajlarinin goriintilendigi ve kolaylikla birim ve koordinat
sistemlerinin degistirilebildigi acilir mendleri iceren alt bolimde bulunan ¢ubuktur.
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Menii |Eiuh-'mju Tool Cubugu
EH test_road - Topcon Toaols
Job Edi Yiew Select Process Report COGO  Window Help

|# B @S S no|fR@|88sad BEILG

£ +|.i i 'D+IL+ +'.~iu '|

Work area

Ready n II‘-‘IBters | bMs |Grumd | Nome 3+

Durum Cubudgu

Menii Cubugu

Mendilerin bulundugu cubuktur. Bircok fonksiyona bu menilerden ulasiimaktadir.

# Job Edit View Select Process Report COGO  Window Help

Menii Fonksiyonlar

Job Mneniisii

e Yeni bir is dosyasi olusturmak, var
New Job. .. Chrl+N olan bir is dosyasini agmak , is i
Open Job... CHI4+O kaydetmek , isi farkli isimle
Save Job Chrl+S kaydetmek , acgik olan isl dosyasini
Save Job As... kapatmak.

Close Job e Acilmis olan is dosyasi ile ilgili

yazdirma islemleri

Import... F3 .
Import from Device... Shift+F3 ° Izlsarldar:j bir dosy.lla all'nma5| ya da
Export... F4 Isarlya dosya verilmesi

e Direk olarak cihazdan dosya
alinmasi ya da direk olarak disariya

Export ko Device,.,  Shift+F4

Print.... Ctri+P dosya verilmesi

Print Preview e Aktif olan is dosyasinin ayarlarinin

Page Setup... yapilmasi

Job Configuration...  Ctrl4-F2 e Daha o6nce acilmis olan s
dosyalarinin gorintilendigi bolim.

Job Info...

1 test_road.ttp
2 ttss.kkp

3 scan-33.ttp
4 sc22.ttp

Exit

Edit Meniisi e Yapilaniglemin ileri, geri alinmasi
e Kes,kopyala, yapistir, sil islemleri

12



Undo Localization Cerl+2

Kaydirma ya da yakinlastirma ayari
Yeni tabaka eklenmesi, yeni nokta ,
hat , ylzey , alan , yol , enkesit
eklenmesi islemleri

Bir hatta nokta eklenmesi ya da

Cut Chrl+
Copy ChH4-C hatta nokta sokulmasi islemleri
Paste 4y e Bir noktaya ait gozlemlerin proses
Delete Del ve dengelemede kullanilmasi ya da
- kullanilmamasinin secilmesi
£oom » e Secilen data dzelliklerinin
Pan mode gorintilenmesi
fdd 4
Disable Ctrl+D
Properties.,,  Ctrl+Enter
View meniisii e Durum c¢ubugu ve diger bircok
pencerenin gorintilenmesi ile ilgili
= secenekler
v Status Bar e Filtreleme seceneklerinin ve diyalog
kutularinin gorintilenmesi
Filters. .. Ckrl+F e Liste penceresinin , harita

v Tabular Yiew Chrl+T

v Map View CErl+M
Occupation View  Chrl+U
v CAD Yiew CErl+K
30 Yiew
Codes
Lavers Ctrl+3
Custornize. .. F12
Options

penceresinin , gdzlem penceresinin,
code penceresinin , 3D goérinim
penceresinin , ve Tabakalarin
gorintilenme secenekleri

Tool gubugunun kisisellestirilmesi
Harita, gozlem, bilgi , imaj , stero
gorintileme seceneklerinin
ayarlanmasi

Select Meniisi

Kullanicinin  sececegi kritere gore
nokta ve gozlemlerin segilmesi

13




Select Al Chrl+A

Select None Shift+Crrl+M
Invert Selection Shift+Cerl+1
Select Poinks. .. Shift+Ctrl+P

Select TS Occupations...  Shift+Cerl+T
Select GPS Occupations... Shift+Chrl+G
Select TS Obs... Shift-+Crl+M
Select GPS Obs, ., Shift+Ctrl+0

Process Menii

Process

i5PS+ PostProcessing F7

adjustment Fa
Localization. .. shift+Fa
Loop Closures.., Chrl+L
Update Surface(s)

Process Properties, .. Alk+Ckrl+P

e GPS gozlemlerinin proses edilmesi
e Gozlemlerin ayarlanmasi

e Lokalizasyon parametrelerinin
hesaplanmasi
o Ucgen kapanmalarinin

goriuntilenmesi
e Yizeylerin glincellenmesi
e Proses ozelliklerinin ayarlanmasi

Report Mentisu

Adjustment Chrl+1
GPS Observations Ckrl+2
Points Chrl+3
Cuality Control kel
TS Observations Chrl+5

Report Configuration,., F9

Dengeleme sonug raporlarinin , nokta
ve gozlem detaylarini iceren , kalite
kontrol sonuglarini iceren raporlarin
degisik ekranlarda gorintilenmesi

Var olan rapor formatlarinin
kisisellestiriimesi ve kullanici tanimh
raporlarin olusturulmasi

COGO Menusu

iki  bélimin  kesisiminin ya da
dogrultusundaki nokta hesabi

Farkh iki ylzey arasinda kalan hacmin
hesabi

Poligon hesabi

Hat ofset hesabi
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Compate Surfaces, ..
Intersection. ..

Inverse Point to Line. ..
Paoint In Direction, ..
Traverse...

Inverse...

Window meniisi

Cascade

Tile Yertically
Tile Horizontally
Arrange Icons

v 1 CaD View

Acik olan pencerelerin yatay ya da
disey olarak siralanmasi ya da tim
ekrana yerlestirilmesi

Tuslarin siraya konulmasi

Gegerli pencerenin gorintilenmesi

Help Menusi

Zontext Help
Help Topics. ..
Feedback
Access Codes...

About Topcon Tools, ..

F1

imlese soru isaretti eklenerek tiklama ile
secim hakkinda yardimin
gorintilenmesi

Topcon Tools vyardim konularinin
gorintilenmesi

Topcon destek birimine soru ya da
program ile ilgili hatanin sistem e posta
programina ulasarak génderilmesi
Topcon GPS web sayfasina direk olarak
erisim

Lisans kodu ile ilgili bilgi alinmasi
Topcon Tools versiyon ve satin alinmis
modiillere ait bilginin alinmasi

Arag Cubugu

Ara¢ cubugu Topcon Tools un ¢ok kullanilan mendlerinin butonlarini igerir. Kullanici bu arag

cubugunu kendi kullanacagi butonlara gore kisisellestirebilir.

@
=
A

I W
|
=

<

|+

T

ST IR K

1a
Ep
T

o]
@

Program acildiginda ara¢ cubugu Meni ¢ubugunun altinda goruntilenir.

e Ara¢ ¢ubugunu goriintilemek ya da kapatmak igin View->Customize ve arzu edilen arag

cubuklariicin enable(ag) disable (kapat) tiklanir.
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e Arag¢ g¢ubugunu tasimak icin mause ile butonun arkasinda bir yer tiklanarak tutulur ve

tasinmak istenen yeni konuma surtklenerek birakilir.

Asagidaki tabloda standart ara¢ cubugunda bulunan tus lar agiklanmustir.

Tus Aciklama
. New Job: Yeni bir is yaratma
:I?: 1. Tus tiklandiginda Creat a new job diyalog kutusu goriintilenir.

2. s dosyasi adi ve isin olusturulmak istendigi klasor segilir
3. Arzu ediliyor ise created by alanina isi olusturanin adi ve Comments
kutusuna da var ise agiklamalar yazilir.

Open Job: Var olan bir is dosyasinin agiimasi
1. Tus tiklandiginda open job diyalog kutusu ekrana gelir
2. lstenilen is segilir
3. Open job tiklanir

Save: Is olusturma asamasinda secilmis olan klasére is dosyasinin kaydedilmesi
saglanir.

import from files: Gézlem datalarinin hard diskten , lokal agdan ya da bir kayit
ortamindan isin igine alinmasi
1. Tiklandiginda import from files diyalog kutusu ekrana gelir.
2. lsin bulundugu klasér , format tipi , gdzlem dosyasinin ismi segilir ve clik
tusuna basilr.

import file from device: gdzlem datalarinin TPS GPS+ alicilarindan, total station
dan, kontrol linitesindenve Topcon memoruy kartdan alinmasi

1. Tus tiklandiginda import file from device diyalog kutusu gorintdlenir.

2. Cihaz segilip Next tusuna basilir.
Detay icin “import from a device “ béliimine bakiniz.

Export to file: Datanin hard diske, lokal aga ya da bir kayit ortamina verilmesi
1. Tus tiklandiginda export to file diyalog kutusu gorintilenir.
2. Kaydetmek istenilen klasor secilir , dosya ismi yazilir ve save tusuna
basilir.

Print: Gecerli pencere ya da tablo yazdirilir.

Undo: yapilan son islem geri alir

Redo: Son isleme geri doner

Cut: Segilen obje kesilir

Copy: Segilen obje (ler) kopyalar

Paste: imlecin gegerli pozisyonuna Windows clipboard da bulunan obje yapistirir.

Zoon in: Aktif pencerede gorinimi yakinlastirma

Zoom out : Aktif pencerede goriiniimi uzaklastirma
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Zoom back: Aktif pencerede bir 6nceki gorlintliyl ekrana getirme

Restore all: Tim projeyi goriintiileme

Pan:Ekrandaki goriintliyld Mouse ile siirlikleyerek istenilen yere kaydirma

Filters :Gozlem ve noktalara kullanici tanimli filtreleme uygulanir.
1. Tus tiklandiginda filters diyalog kutusu gorintilenir
2. istenilen filtreleme secenekleri secilir ve apply tusuna basilir

Tabular view : Is icindeki datalari iceren liste penceresini ag/kapat

Map view: Gozlem datalari ve data toplanmis noktalarin goriintllendigi pencere

CAD view :Dizayn datalarinin goriintiilendigi penceredir.(noktalar , hatlar,yollar ve
yuzeyler)

Occupation view: is datasindaki izlenen uydu zaman grafigi penceresini a¢/kapat

Codes: isdeki kodlamalarin bulundugu liste penceresi

GPS+ PostProcessing: is icindeki tim gdzlem datalarini proses motoru ile proses
eder

3
-

Adjustment: AgI dengeler

I="

Configlre reports: Rapor ayar penceresini agar.

"

Context Help: imle¢ ile secilen obje icin acilir pencere de yardim igerigi
gorlntdlenir.

CAD Arag ¢ubugu tuslar
Tus Aciklama
a Add Point: is e nokta ekleme

+ 1. Tus tiklandiginda imleg sekli degisir ve nokta ekleme isaretgisi olur.
2. CAD penceresinde nokta eklenecek yer tiklanir
3. Eklediginiz noktaya ait bilgileri add point diyalog kutusuna girin
4. Ok tusuna basin. Tus tekrar tiklandiginda imle¢ normale déner.
. Add line: is e hat ekleme
+ 1. Tusu tiklayin imleg¢ nokta ekleme isaretgisi olur

2. CAD penceresinde hattin baslangic ve sonuna tiklayin hat igin
baslangi¢ ve bitis olmak lizere iki nokta tretilmis olur.
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Add surface: Secilen noktalar ve hatlar arasina yeni ylizey olusturma

+
- Append points to line: Hattin sonuna nokta ekleme
+
—r Add points to line:Tiklanan yere nokta ekler ve bir hattan iki hat olusur
.1-.
o Add points and line to surface : Ylizeye noktalar ve/veya hatlar ekleme islemi
+

X

Erase: Secilen objeyi siler

Add road:Yol ekleme

L 1. Tusu tiklayin
2. Add road diyalog kutusuna bilgileri girin ve OK tusuna basin
Add X-section template: En kesit sablonu ekleme
—F 1. Tusu tiklayin.

2. Add X-section diyalog penceresine ismini girin , kazi dolgu egimini
girin ve OK e basin.
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Durum Cubugu

is dosyasinin genel birka¢ parametresi buradan olduk¢a hizli ve kolay bir sekilde degistirilebilir.
Degistiriimek istenen bolim cift tiklandiginda segim listeleri gelecektir.

IReadv Meters ,Mils Datum Latl, Lon, EILH | WGS84 | 3=

WG58 v I

WGSS4

IDatum Lat, Lon, EH.P:I

|Meter - |
Ground

IFeet
Gons Grid
LISFeet Mils Datum Lat, Lon, EllLH

Radians WG534 Lat, Lon, ENILH

More,,,

Daturn Lat, Lon, Elevakion

Baslangi¢ Diyalog Kutusunu Kullanmak

Topcon Tools calistirildiginda Startup diyalog kutusu ekrana gelir.Pencere daha 6nce agilmis olan is

dosya isimlerini listeler.Listede is ismi, bilgisayarda hangi klasérde oldugu , olusturulma tarihi, en son

calisma yapilan tarih gérintilenir.

H Startup

Job niame

| Job location

Created

I Last accessed

& Test-Linework
@

&

Test For Yalery
tlsv job
localiz-test
test-local File
GPS_Static

ﬁ Static file_dave
@ oL

C:\Documents and ...
C:\Documents and ...
C\Documents and ...

C\Documents and ...
Ci\Documents and ...
C\Dacuments and ...
CtiDocuments and ..,
C\Documents and .,

15:41:35 20 Jun ...
14:42:10 21 Jun ...
13:03:29 22 Jun ...
18:39:28 04 Jul ..
15:42:36 04 Jul ...
12:04:31 05 Jul ...
11:29:37 12 dl ...
17:36:02 12 ul ...

15:41:35 20 Jun 2005
15:23:51 22 Jun 2005
16:59:15 15 Aug 2005
12:17:54 01 Nov 2005
18:42:36 04 Jul 2005

16:36:22 12 Nov 2005
13:26:23 22 Jul 2005

16:59:43 15 Aug 2005

Mew job

Open job

Browse...

Delete job

Close
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Yeni Is Dosyasi Olusturma : New Job

Bu tus tiklanarak ok denildiginde verilmis olan isimle secilmis olan klasérde bos bir is olusturulmus
olur.

1- Yeni bir is dosyasli olusturmak icin asagidaki sirayi izleyiniz.
a. Startup diyalok kutusunda New Jonb tusunu tiklayin
b. Arac cubugundaki New tusu da ayni islemi yapmaktadir.
c. File menistnden Job->New Job da ayni islemdir.

:@: Job name | Job location Created Last accessed A New job
ﬁ Surfaces C:\Documents and Setki..,  13:25:56 19 De.,. 13:55:18 25 Dec 2005
ﬁ Road C:\Documents and Setti...  11:51:12 31 Oc... 18:37:15 24 Dec 2005
- -2 Ci\Documents and Setki..,  12:32:51 23 De... 16:18:58 24 Dec 2005
= Browse...
Open Job Eg
v
Close Job ¥ Close

2- Asagidaki bilgileri girin
a. Job Name: is ismi , Created by: isi olusturan kisinin ismi , Comment: varsa gerekli
actklama bilgisi
b. Browse butonunu tiklayarak is dosyasinin hangi klasérde olusturulmasini istiyorsaniz
segin
c. Configuration dan gerekli konfiglirasyonu secin.Standart GPS+GLONASS statik
goOzlemleri icin GPS+ secilmelidir. Detayh bilgi ilgili b6limde incelenebilir.
3- Ok tusuna basilarak yeni is dosyasi olusturulmus olur ve bu bos is dosyasi ekrana agllir.

Var olan is dosyasi agilmasi Opening a Job

Topcon Tools da *.tpp uzantili is dosyalarini ¢ift tiklayarak acabileceginiz gibi Windows Explorer
Gzerinde *.tpp uzantili dosya tutup siirtikle birak yolu ile de programda acilabilir.

1- is dosyasi acmak icin asagidaki yolu izleyin

a. Startup diyalog kutusunda listelenen var olan isimlerden agmak istediginiz ismin
Gzerini gift tiklayarak

b. Startup diyalog kutusundaki listeden agmak istediginiz is ismini secip open jop tusuna
basarak

c. Browse tusuna basarak bilgisayarinizda hangi klasérden dosya a¢mak istiyorsaniz
secerek
Arag cubugunda bulunan Open tusuna basarak
Meni ¢ubugundan Job->Open Job secerek
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=

Job name
ﬁ Surfaces

- Fmad——

New Job

Close Job

Save Job [g

tr5-2

Job location

C:\Documenkts and Setti...
Ci\Documents and Setti...
Ci\Documents and Setti...

Created

13:25:56 19 De...
11:51:12 31 Oc...
12:32:51 23 De...

Last sccessed A New job
13:55:18 25 Dec 2005
18:37:15 24 Dec 2005 Open job
16:18:58 24 Dec 2005

Delete job

| €

Dosya Kaydetme Saving Job

Dosya kaydetmek icin asagidakiler yapilir.

Arag¢ cubugunda Save tusu tiklanir

Men ¢ubugu Job->Save job tiklanir

Farkh isimle kaydetmek icin Job->Save Job as tiklanir ve gelen diyalog kutusuna verilmek

istenilen yeni isim ve kaydedilmek istenen klasér segilir.

Dosya kapatma : Closisng Job

3ob

Mew Job
Cpen Job

Close Job !

Dosyay! kapatmak icin Menii gubugundan Job->Close Job tiklanir.

Mew Job
Open Job
Save Job

Eger is dosyasinda bir islem yapildiktan sonra kaydedilmeden kapatma islemi yapilmak istenirse

Mew Job.., Chrl+M
Open Job..,. Chrl+0
Save Job Chri+S

Close Job &

konu ile ilgili uyari mesaji ¢ikar Yes tiklandiginda var olan klasériin icinde dosya kaydedilir.

Meni cubugunda Job->Exit tusu dosya kaydedilip kapatildiktan sonra Topcon Tools dan cikilir.

Dosyanin silinmesi :Deleting a Job

Topcon Tools bir is dosyasi icin Ug ayri dosya kaydeder.Bir isi tamamen silmek icin bu ¢ dosyay!

da silmek gereklidir.
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i~ Open a job

Job name I Job location J Created ] L Last accessed A Ooeriich
& surface-1 C\Documents and Setti,., 132523 19De,,, 15:52:30 25 Dec 2005 i

g C:\Documents and Setti,., | 13:25:56 19 De.., | 13:55:18 25 Dec 2005

@ Road C:\Documents and Setti,..  11:51:12 31 Oc... 18:37:15 24 Dec 2005 Browse...
ﬁ codes-layers-2 C:\Documents and Setti,..., 12:32:51 23De... 16:18:58 24 Dec 2005

@ adijustment C:\Documents and Setti... 13:05:48 30 No... 15:50:24 23 Dec 2005 Delete job
ﬁ codes and lavers Ci\Documents and Setti... 16:28:35 21 De.., 11:47:20 23 Dac 2005

& cyrface-3 Ci\Documents and Setti,., 15:22:12 21 De,., 16:28:20 21 Dec 2005 ol

=~ ose
£ ¥

Bir is dosyasini silmek igin startup listesinden silinmek istenen isim segilir ve Delete Job tusuna
basilir.Onay sorusu ekrana gelir silme islemi onaylaniyor ise ok tusuna basilir ve dosya silinmis
olur.

Is Ayarlari

Job Configuration diyalog kutusu ile datalarin gorintiilenmesi ve proses edilmesi ile ilgili
ayarlamalarin yapilmasi saglanir. Bu ayarlara ulasmak icin Meni c¢ubugunda Job->Job
Configlration ya da Create a new Job (yeni is dosyasi olustur) diyalog penceresinde Edit
configuration tusu tiklanir.

2 Job configuration

Fredsions | Tme | Roads | Angles |

El Coordinate Syskems Digils after decimal

% ;I;f: Digtances I3 —]
El Cuaity Conbral Coardinates{M.E] I3 =
= Process Heights B -
5] adjustmert; =
2] = Computations Angles [zeconds] |4 =

EI P>+ PostProcess Angles [Dec. degrass] I? =

Lat Lon [s2conds)] B =

LatLar [0 ex degrees) E] —

Aea II:I =

Wolumes: |1 =

S awe configuration | Lizt configuralicns (] 4 Carncel |

e Diyalog penceresinin sol tarafinda bulunan segenekler ayarlamalar icin kullanilir.Asagidaki

bolimler bu secenekleri aciklamaktadir.
e Sag bolim solda segilen segenege ait parametrelerin gérintilendigi bolimdir.
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e Save configliration tiklandiginda yapmis oldugunuz ayarlar kaydedilebilir. Olusturulmus
standart ayar dosyalari istenildiginde baska dosyalarda da kullanilabilir.

e List configuration tusu tiklandiginda ayarlarin listesi ekrana gelir. Default olarak gelen
konfiglirasyon sizin is ayarlariniz ile farklihk gosterebilir dolayisiyla is dosyanizda
calismaya baslamadan once kendinize 6zgli ayarlamalari yapiniz.Listede standart ayarlar
ve kaydedilmis ayarlar goriintilenmektedir. Arzu edilen segilir ve Load tusuna basilir.

& Confinurations list

DiERS

Rename
GRS+

Dialats

Load Cloza

Gorunti secenekleri: Display Options:
Sol segeneklerden Display secildiginde sag tarafta ilgili parametreler gérintilenir.

e Precision (Duyarliik) sekmesi Olcii degerlerinin  noktadan sonra ka¢ hane
goriintllenecegine ait parametreleri icerir.

%2 Job configuration

= Precisions | Time | Roads | Angles |
fiz) Coordinate Systems Digits after decimal
&= o Distances E - |
5 Save .
2 Quality Control Coordinates(N_E) E —]
= 2] Process Heights E =
1| Adjustment
32| TS Computations /Angles [seconds) 14 —
i=| GP5+ PostProcess Angles [Dec.degrees) I? x- |
|Lat Lon (seconds) 5 —
Lat Lon [Dec.degrees] i8 B |
Area {0 = |
[Wolumes i - |
Save configuration| List configurations ok Carcel
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Time (zaman) sekmesi GPS zaman ofset degerini icerir. GPS ile kaydedilen datalarin
saatleri O ofset degerine goredir. Tlrkiye de yaz saati uygulanirken GMT+3.00 kis saati

uygulanirken GMT+2.00 segilir.

12 Job configuration 1| il
%= Display Precisions  Time | Roads | Angles |
= Coordinate Systems GPS Time Zone Offset 1EMT =

§J Units

-
+

S| save

Save configuration

List corfigurations

1

GMT

= GHMT+1:00
i5] Quality Control GMT+2:00
-1 =] Process GMT+3.00
i=] Adjustment gm?i%
E_E] T5 Computations GMT:43|:|
EE] GP5+ PostProcess GMT+5;I]EI
GMT+5:30
GMT+5:45
GMT+6:00

GMT+6:30 ~

oK

Caricel

e Raod (yol) sekmesi aksin gosterim seklinin kilometreye mi istasyona gore mi olacagini

ayarlar.

12 Job configuration

=] Display

E

_—

Coordinate Systems
Units

Save

Quality Control
Process

Precisions 1 Time  Roads } Angles I
Display CL Pos as | Chainage

|Elarticm

[ adjustment
i_‘._:'j T5 Computabions
=] GPS+ PostProcess

Save configuration| List configurations (1] 8

Cancel |

e Angels(agl) sekmesi agl degerlerinin hangi formatta gorintilenecegini ayarlar
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12 Job configuration E”?]

(=] Display Precisions | Time | Roads Angles |
{ff} iirdmate Systems Ares Idd‘ml‘n‘ss o j
= LS
[ save LatLon | dd*rm'ss 5" |
[i=) Quality Contral et
- Process dd.ddd
5] Adjustment dd mm sss

(=] T35 Computations
(=] GPS+ PostProcess

Save configuration| List configurations (114 Cancel |

Koordinat Sistem Ayari

Herhangi bir Topcon Tool is dosyasi grid ya da secilmis bir datumda ya da diizlem koordinatlarina
sahip noktalari icerir. Kordinat sistem diyalog kutusundan calisilacak koordinat sistemi secilir. Topcon
Tools iginde Tirkiye ye ait 3 derecelik Memleket koordinat sistemi (ED50) ve ITRF96 projeksiyon
koordinat dilimleri standart olarak ayarlanmis olarak kurulur. Hangi sistemde calisiliyor ise Projection
secimi altinda Europe altinda Turkey bulunur ve oradan c¢alislan is dosyasina ait dilim orta meridyeni
secilir. Projeksiyon secildiginde Datum otomatik olarak gelecektir.

12 Job configuration E|@

=] Display Projection |“'§'_: None j Custor..
=l Coordinate Systems e
S Lnits Datum |Wiisa4 =l custom.
[i=] save
i=| Quality Contral rc ; J
- [t=] Process
=] Adjustment . ids Li
l :| djustrmen . Geoid | > Geoids List..
5] 15 Computations
=] GPS+ PostProcess Coordinate ype |Datum Lat, Lon ELH -

Save configuration| List configurations 0K Cancel
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Yeni Projeksiyon Tanimlama Custom Projection

Yeni bir projeksiyon tanimlamak igin

1- Projection sec¢imi yaninda bulunan Custom tusunu tiklayin

2- Custom Projections List penceresinde
e Add tusunu tiklayin
e Listeden bir tanimh projeksiyon silmek i¢in secerek delete tusuna basin

k4 Custom Projections List

MName | Reqion Daturm Moke Projedtion Type |

Add Hemowve Cloze

3- New Custom Projection (yeni kullanici tanimli projeksiyon ) penceresinde asagidaki

yazilan sirayi uygulayin ve OK tusuna basin.

e Name: tanimlayacaginiz projeksiyonun ismini yazin

e Projection type: Listeden projeksiyon tipini secin.(Turkiye de Transfersal
Mercator kullaniimaktadir.

e Central meridian : Dilim orta meridyenini yazin. Scale: 3 derece igin 1 alti
derece icin 0.9996 yazin. Lat= = olarak kalacak, East=:500000 yazin.

e Region: Ulke ismini girin.Tanimladiginiz projeksiyon ismi standart listede
burada yazdiginiz Region ismi altinda goriintilenecektir.

e Notes: Varsa yazmak istediginiz notlar bve agiklamalari yazin

e Datum: Projecsiyonda kullanacaginiz datumu segin.

4- Bitirdiginizde Ok tusuna basin ve Close tusuna basin.

::1 New Custom Projection @@

General l
Name |Perrell County
Prajection Type | Transverse-Mercator L!

Name ] Value

Central meridian 0°00'00.000

Scale 1

Lato 0°00°00.000

EastO 0

MNorthO 0 =

%A Custom Projections List
Mame | Region Datum Mate

< Pertell Caunty  State WESES

Region
I s
Mate Add Femave l Cloze
Datum [wGsed |
DK % Cancel | Apply ]
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Kullanici Tanimh Datum Eklenmesi add a datum

Yeni bir datum tanimlamak igin

1- Datum sec¢imi yaninda bulunan Custom tusuna basin
2- Custom Datum List penceresinde
e Add tusuna basin ve sirasi ile uygulamaya devam edin
e Listeden silme yapmak istiyorsaniz sileceginiz datumu secin ve Remove tusuna
basin

;ﬂ Custom Datums List

Mame | Mote | Elipscid | Dx ) | ovimd | oz o) | Ra ey | Ry | R20 | Scale |

Add Remove Cloze

3- New Custom Datum (yeni kullanici tanimli datum) diyalog penceresinde gerekli

bolimler girilir.
e Name: Datum igin isim girin
e Elipsoid: Yaratacaginiz datumda kullanilacak elipsoidi se¢in
e DX,DY,DZ; elipsoid 6teleme parametrelerini girin
e RX,RY,RZ: elipsoid dénuklik parametrelerini girin
e Scale: dlgegi girin
e Notes: Yazmak istediginiz not ya da aciklama varsa giriniz.

Ok tusuna bastiginizda tanimladiginiz datum listeye eklenecektir.

NOT: Bu parametreler yeni olusturulan datumun WGS84 den olan
transformasyon parametrelerini tanimlar ve asagidaki esitlik kullanilarak hesap

yapilir.
D 6 1 RZ -RY| |X
% = |pyl +(1+Scale-10 )-|_p7 1 RX|' |V
Ll wes— s DZ RY -RX 1 Z| new — datum
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4- Bittiginde Close tusuna basilir. Boylece yeni olusturulan Datum artik datum se¢cme
acihr listesinden secilebilir. Yeni bir projeksiyon tanimlamadan o6nce datum
tanimlamasi yapilmalidir ki yerel datum projeksiyon tanim penceresinde segilebilsin.

New Custom Datum : Datum None @

General |
Mame |CA RY ") 1.5
Ellipsoid |WGSE¢1 Ll FZ " 15 &d Custom Datums List il
Dx(m |3 Scale [1.5 Name | Note | Elipsoid | Dx¢m) | py(m)| pz(m)| R | Ry | Rz Scale |
o 3 [® cA None WwGSS4 35,0000 3,0000 30000 1,5000 1,5000 1,5000 [EWERE
DZ m) |—3 MNate
R 15

Add Remaove | Cloze |

Birim se¢imi Unit Selection

Calisilacak is dosyasi icin mesafe ve aci birimi segilir.

74 Job configuration

[=] Cisplay

Coordnate Systems

Brgular et | LM ]

[i] save

GQuality Cantrol
= Procoss

=) Adjustmgg |Melers
TS nukations
E BF=+ FoskProcess IFEE‘

LSFeet

Gons
Milz
Fadians

—Fymumu.. | - ! Cancel

Kayit Segenekleri

Burada otomatik kayit dosyasinin hangi, cihazdan alinan dosyanin nasil kaydedilecegi ve
otomatik kayit zaman aralig1 ayarlari yapilir.Otomatik kayit herhangi bir aksi durumda data
kaybini 6nlemek icin 6nemlidir. Otomatik kayit icin default kayit yolu: C:Documents and
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Setting\<username>\TopconTools\TopconToolsAutoSave” klasoruddr.

2 Job configuration

:=| Display Folder For Backup | \Backuph

Coordinate Syst 3 v Ly
L:;:; PRIy Backup files from devices |Dvemda existing LI
Save Backup Interval (min) f10 =|

Quality Contral
=l liz] Process
- [ adjustment

i=| T5 Computations
i=] GPS+ PostProcess

Save configuration| List configurations DK Cancel

Kalite Kontrol Ayarlar
Quality Control secildiginde sag panelde asagidaki secenekler bulunur;

e Point precisisons (nokta duyarlligi) sekmesi statik ve kinematik Ol¢li noktalarinin
yatay ve disey duyarliginin ayarlarini icerir.Eger noktanin yatay (std Dev Hz) ve diisey
(Std Dev u) standart sapmalari bu degerden kot olursa noktalar Points sekmesinde ,
Harita ekraninda ve raporlarda kirmizi renkte goriintilenir.

#2 Job configuration EWE

i= Display T5 Obs Precisions ] GPS Obs Precisions | Automatic Tests
iZ| Coordinate Systems Loop Closure Precisions Point Precisions | DL Obs Precisions
1= Units
iZ Save : . .
= Quaity Cantral Static Horizontal Precision [m) [1
== Process Static Vertical Precision [m) 3
i= e ) Kinematic Horizantal Precision [m) [1
1= TS5 Computations
1= GPS+ PostProcess Kinematic Vertical Precision [m) [3

Sawe configuration| List configurations Ok Cancel
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TS Obs Precision sekmesi Total station ile yapilan okumalarda mesafe ve yatay/dlsey
acl duyarhgini set eden bolimdir.Eger deger ag dengelemesinde bu duyarlik
kriterinden kot olursa bu okumalar TS Obs sekmesi , harita gériinimu ve raporlarda
kirmizi renkte gorintilenir.Bu okumalar son ag dengelemesinde kullaniimaz.

%2 Job configuration

Save configuration| List configurations 0k Cancel

Display Loop Closure Precisions | Point Precisions | DL Obs Precisions |
Coordinate Systems TS Obs Precisions | (GPS Obs Precisions | actomatic Tests |
Linit=

Save . g

TR T5 Distance Precision [m] [0.03

Process T5 WA Precision [sec.) |1 1]

Adjustment TS HA Precision (sec.) [0

TS Computations
GP3+ PostProcess

GPS Obs Precision sekmesi RTK vektorlerinin ve statik/kinematik proses vektorlerinin

[

a a
N(Res(e)) +(Res(n))”
ve

gozlem duyarhgini ayarlandigi sekmedir. Eger yatay
disey ag dengelemesi sonucundaki RTK ve GPS proses sonug karesel ortalamalari bu
sekmede girilen degerden kotl ise GPS obs sekmesinde , harita ekraninda , ve
raporlarda kirmizi isaretlenir.
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%2 Job configuration @@

=] Display Loop Closure Precisions | Point Precisions | DL Cbs Predisions |
Coordinate Systems TS Obs Precisions GPS Obs Precisions I Automatic Tests |
[=] units
$=| Save ; -
Quality Control RTK Harizontal Precision [m) ]l
Quality Contro
= Process RTK Vertical Precision [m) I3
| Adjustment. PP Static Horizontal Precision (m) [03
TS Computations
| GPS+ PostProcess PP Static Vertical Precision [m] I
PP Kinematic Horizontal Precision [m)] I
PP Kinematic Vertical Precision [m) 13

Save configuration| List configurations 0K Cancel

e DL obs precision sekmesi : Bu sekme dijital nivo élgimlerinin duyarliginin ayarlandig
ekrandir.Eger ag dengelemesi sonucunda yikseklik hatasi bu degerden koti ise DL
obs sekmesinde ve raporlarda bu dijital nivo gézlemleri kirmizi renkte goriintilenir.

%2 Job configuration E|®

=] Display T5 Obs Precisions | GPS Obs Precisions | Automatic Tests |
i=| Coordinate Systems Loop Closure Precisions | Point precisions DL Obs Precisions

1= Units

1= Save

= DL Vertical Precision [m) [I]_EID‘I

B Quality Contral
= [¥=| Process
[5] adjustment

1= TS Computations
GPS+ PostProcess

Save configuration| List configurations aK Cancel |
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Automatic Test sekmesi hangi kalite kontrol testlerinin arka planda c¢ahstirilarak QC
sonucunda hangi noktalarin ve gdzlemlerin gecemediginin isaretlenmesi ile ilgili ayar yapilir.

%2 Job configuration

[_Ei Display Loop Closure Precisions | Poink Pracisions | DL Obs Precisions |
(=] Coardinate Systems TS Obs Precisions | GPS Obs Precisions Automatic Tests
=] Units
[75] Save 3
= ™ ‘wam Float solufions
=} Quality Control @ R .
=[] Process v F. Precisions
=] adjustment ¥ PP Static Precisions
=] TS Computations ¥ PP Kinematic Precisions
=] GPS+ PostProcess Iv Point Standard Devistions
¥ Identical Paints
¥ Misnamed GPS Occupstions
[™ Misnamed Autotopo Flovers

Save configuration| List configurations 0K Cancel

Arka planda ¢alismasini istenilen test kutucugu isaretlenir.Secenekler asagida listelenmistir.

e Warm float solution testi: isaretlendiginde float ¢coztiimler liste sayfasi, harita ekrani
ve raporlarda kirmizi renkte goruntilenir.

e RTK precision testi: RTK o6lgcmeleri siresince kabul edilemeyecek degerlerle ilgili
gereksinimler test edilir. Arzu edilmeyen duyarlktaki gdzlemler liste, harita ekrani ve
raporlarda kirmizi renkte goriintilenir

e PP statik precision testi: Statik 6lci oturumlarinin arzu edilen duyarlk gereksinimleri
ile ilgili testtir. . Arzu edilmeyen duyarliktaki goézlemler liste, harita ekrani ve
raporlarda kirmizi renkte gorintilenir

e Point Standart deviation: (nokta standart sapmasi) dengeleme sirasinda nokta tipine
gore duyarhk kriterine uymayan noktalar harita ekrani ve raporlarda kirmizi renkte
goruntilenir . Noktanin 06zelliklerine (properties) bakildiginda Quality control
sekmesinde “istenilen duyarliga ulasilmamistir” “Failed to match the desired
precision” yazacaktir.

e identical points testi.(Ayni nokta testi) ; Test iki nokta arasindaki cok kiciik
mesafeleri test eder.Kabul edilebilir en kiigclik mesafe nokta tipine gore belirlenir, bu
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kriterin disinda kalan noktalar harita ekrani ve raporlarda kirmizi renkte goriintilenir.
Nokta oOzellikleri segildiginde QC sekmesinde “Bu nokta ...... isimli noktaya ¢ok yakin.
Muhtemelen ayni nokta” “This point is very close to point <point name> They are

III

probably identical” mesaji yazacaktir.

e Misnamed GPS occupations testi: Sadece statik Olgller igcin gecerlidir. Test bir
noktadan 30m yakininda ve isimlendirilmemis noktalari test eder. Eger var ise bu tir
noktalar ve Olclleri harita ekrani ve raporlarda kirmizi renkte goruntilenir .

e Misnamed autotopo rovers testi: Kinematik olciler icin gecerlidir. Test bir noktadan
30m yakininda ve isimlendirilmemis noktalari test eder. Eger var ise bu tiir noktalar

ve Olclleri harita ekrani ve raporlarda kirmizi renkte gérintilenir

e Loop Clousers (Lup kapanmalari )sekmesi Ucgen kapanmalarinin yatay ve diisey
toleransi bu sekmede girilir.

#2 Job configuration @@
l
1

=] Display TS Cbs Precisions | GPS Obs Precisions | Automatic Tests
] Coordinate Systems Loop Closure Precisions ] Point Precisions | DL Obs Precisions
=] units
= S
|:_:| ._. T Horz Tolerance abs. [m) il
Bl Quality Control
- |==:! Pracess ert Tolerance abs. (m) [3
1= Adjustment
= Haorz Tolerance rel, 10
= TS Computations (ppr) |
i= GPS+ PostProcess Wert Tolerance rel [ppm] 10

Save configuration| List configurations oK Cancel |

Proses Ozellikleri Process Properties
Proses secildiginde sag panelde asagidaki secimler gorintilenir.

e Adjustment (dengeleme) ; dengelemenin giiven seviyesinin ayarlandigi bolumdar. Ag
dengelemesinden onceki kabul edilebilirlik testidir.Default gliven seviyesi %95 tir ve
reddetme kriteri Quality Control e goredir.
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"2 Job configuration E|@I

Display

Coordinate Systems
Units

Save

Quality Control
Process

'lEE| T5 Computations

[i5 GP5+ PostProcess

il

T
1

kil

I
I

1
il

Save configuration| List conhigurations

 Confidence Level -

T BE%

s g5

- <

Rejecton Critenon

" By Quality Control

" Tau Criterion

¥ Analyse Repeated Obsarvations
¥ Analyze ldertical Points

v Control Tie Analpsis

0K

Cancel

TS computations sekmesi: Total station oOlgllerine uygulanacak refraksiyon katsayisinin

secimi yapilir.

72 Job configuration @EJ

;=] Display
=] Coordinate Systems
=] urits
:_,—_, Save
=] quality Contral
=1-{&=| Process
=] Adjuskment
=] 5 Computations
2| GPS+ PostProcess

li=

Save configuration| List configurations

— Refraction Coefficient -
0
014
02
0K
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GPS+ PostPeocess sekmesi: Uydu yikseklik agisi , istasyonda minimum bekleme siresinin

belirlendigi sekmedir. Surekli kinematik oOl¢linin aktif ya da aktif degil olarak secildigi
bolimddr.

"3 Job configuration

[¥5] Display Elevation Mask 15 =
E:E::inal:e Syeterns e |GF'S+ ﬂ
E?l Save Stalic

fuality Conkral Mirirmurn duralion

= Process Fived Ti

[S adiustment [Five3 Tirre =

T5 Corputations Min. obs. imefzec) EX

GPS+4 FostProcess

| Enahle continuous kinermatic

Save configuration|  List configurations

OF. Cancel
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DATALARIN PROGRAM iCINE ALINMASI

Datay! almadan 6nce Topcon Tools da yeni bir is dosyasi acilir ve sonra GNSS alicisindan ya
da bilgisayardan is dosyasi alinabilir. Bilgisayardan Topcon Tools is dosyasi icine alinabilecek
dosya formatlari agsagidadir.

* Coordinate files
TOpSURYV Coordinates (*.txt)
CORS Coordinate files (*.txt)
CR-5 Files (*.CRS5)
Custom Text Format files (*.%)
FC-4 Points (*.xyz; *.fc4; *.pnt)
FC-5 Points (*.xyz; *.fc5; *.pnt)
GTS-210/310-10 Points (*.xvz;
. pnt)
GTS-210/310-12 Points (*.xvz;
*.pnt)
GTS-7 Points (*.xyz; *.pnt)
Name.E.N.Z.Code (*.csv)
Name.Lat.Lon Ht,Code (*.csv)
Name N.E.Z.Code (*.csv)
NGS Datasheet file (*.htm;
* html)

+ DL Obs File (*.dL *.txt; *.lev)

* Field Orientation Data (*.foe; *.fos)

+ Field Scan Data (*.fsc)

+ GIS files
Shape files (*.shp)

(continued below)

* Design Files
DWG files (*.dwg)
DXF files (*.dxt)
LandXML files (*.xml)
TN3 Surface files (*.tn3)
* GPS Obs File
Custom Text Format (*.%)
Topcon Vectors (*.tvf)
TDS RW35 GPS Obs (*.rw5; * . raw)
Topcon XML GPS Obs (*.xml)
* GPS+ Raw Data Files
Compact RINEX fiels (*.77D; *.77G;
. 7IN)
RINEX files (*.770; *.77G: *.77N)
SP3 & SPC3 files (*.sp3)
TPD files (*.tpd)
TPS / JPS files (*.tps: *.jps)
» Localization Files (*.gc3)
« TDS Raw Data Files (*.rw3: *.raw)
» Topcon Tools Jobs (*.ttp)
* Topcon XML Files (*.xml)

* TopSURV PC Job Files (*.tlsv)
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TS Obs Files * Code Library

Custom TS Raw Format (*.*) DBF Code Library file (*. dbf)
FC-5 Raw (*.raw; *.dat; *.fc53) TDD Code Library file (*. tdd)
GTS-210/310 Eaw (* raw: * _dat: XML Code Library file (*. xml)

*.gtsy F.gth)

GT5-6 No Station Raw (*.raw;
* dat;*.gts; *.gts6; *.gt6)

GTS5-6 Raw (*.raw; *.dat; *.gts:
*.gts0; *.gto)

GTS-7 Raw (*.raw; *.gts; *.gts7;

* Roads File
CLIP Road Files (*.PLT)
ISPOL Road Files (*.ALI)
TDS Road Files (*.RD35)
Topcon MC Road Files (*.RD3)

* gt7) Topcon SSS Road Files (* . HAL)
GTS-7+Raw (*.raw; *.dat; *.gts; TopSURYV Road Files (*. THL)
*.gtsT; *.gtT) LandXML Roads (*.xml)
TDS RWS5 TS Obs (*.rw3: *.raw) Topcon XML Roads (*.xml)
Topcon XML TS Obs (*.xml) VGP Roads (*.VGP)

TS Obs Files
TDS TP5 (*.tp5; *.xlt; *.xst;
*.xml)

Topcon 555 XS-Template (*.xtl)
Topcon XML X-Section
Template (*.xml)

TopSURV XS Template (*.xst)

Dosya

alinirken ayni formatta bir ya da birden fazla segim vyapilarak islem

gerceklestirilebilir.Topcon Tools sirikle birak teknigini de dosya alirken desteklemektedir.

Arzu edilen is dosyasi acilir

Windosw Explorer calistirarak almak istediginiz dosyalarin bilgisayardaki klasori acilir
Klasor ya da dosyalar segcilir

Dosyalar Mouse ile siriklenerek Topcon Tools pencerelerinden birisi (zerinde
birakilir. Bu yontemde Topcon Tools siirtikle birak ile getirilen dosyalarin formatlarini
otomatik olarak algilar.
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w4 Rosic P - Topcon Tooks - [Map View)
i
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Bu islemi uygularken Mouse sag tusu tiklanir ise Drop options diyalog kutusu
goruntilenir.Devam etmek icin OK tusuna basilir.

e Format tipi segilir

e Recurse folder secenegi isaretlenir ise secilen klasoriin alt klasorleri icinde bulunan
data da alinir.

;-H Drop options

¥ Recurse folders
“You are tving bo import 2 files

Ok

Eger format secilmez ise Topcon Tools slirikle birak ile alinmak istenen dosyalarin isim
uzantilarindan ve iceriklerinden formatini belirler.
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Kullanici Tanimhli Format Dosyalarinin Olugturulmasi ve Alinmasi

Topcon Tools kullanici tanimli ASCIl dosya formatini destekler.

1-

Topcon Tools icine koordinat dosyasi almak icin agik olan is dosyasinda mentiden Job-

>Import , ya da F3, ya da Ara¢ cubugunda Import tusuna basilir.

genisletilir ve Custom Text Format segcilir.

Alinmak istenen dosya klasori bulunur

Arzu edilen gelismis secenekleri (Advanced) secilir.
a. Projeksiyon ve datum segilir

Format Name agilir menisiinde Coordinate File yanindaki arti isareti tiklanarak mena

b. Alinan dosyadaki nokra yukseklikleri Ortometrik ise bu kutucuk isaretlenir aksi

taktirde kotlar elipsoidal olarak algilanir.

c. Control isaretlenir ise alinacak listedeki tiim noktalar sabit nokta olarak
isaretlenir aksi halde kontrol noktasi olarak kabul edilmezler.

ise)

%4 Import

Custom format ayarlarini set etmek icin Open tusuna basilir (ya da save eger veriliyor

?X

ki [t ECEE
[H}FP_topo_Novzo.TXT
D tapetlsy

File name: |PP_topo_MNow20,T<T

Format narme: I I Custorn Test Format [*.7]

W Advanced options

l" 7 None

Open k

Frojection j Custom
Dratuim }WGSE" L] Custom
Linear Unit |USFeet -l
[ Orthometnc Height

¥ Contral
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6- Custom
den de

Drelimiters

Maoithing
E astifg

Mote
FulCodes

[ lgrore firgt fne

Farmat narme

File exterzion

2 Custom format properties

Cooidinate systzm

Height
Code 7P

[ FullCodes include Code, Sting and ControlCode
[ FullCodes include Code and Attribute

format properties diyalog kutusunda delimeters( ayirici) coordinate system
koordinat sistemi secilir.

[?]X]

Poirth L

Semicolon

|:x

0k

Cancel |

7- Alinacak dosyadaki elemanlarin sirasina gore sol taraftaki listeden secim yapilir ve

I+ tusuna basilarak sol taraftaki listeye eklenmesi saglanir. Yanls bir ekleme

yapildi ise ya da sol taraftaki listeden ¢ikartma yapilacak ise = tusuna basilir.

8- Sol taraftaki elemanlarin siralamalarinda degisiklik yapilacak ise ; siralamasi

degistiri
basilir.

Imek istenen secilir ve yukari icin Move up asagi icin Move Down tusuna
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72 Custom format properties

Delimiters | Comma

Coordinate system |Erid j

Poirith urnk
Height Marthing

Ezf: > [ | Move Up
FullCodes

< | Maove Down ‘

[ lgnore first line
[ FullCodes include Code, Sting and ControlCode
[ FullCodes include Code and Attnbute

Format name |

Fille extension  |**

0K Cancel

9- Ignore first line isaretlenir ise alinacak olan dosyadaki ilk satir dikkate alinmayacaktir.
10-Kullanici tanimh dosyadaki nokta kodlarinin tirine goére arzu edilen secenek
secilebilir.
a. Fullcodes include codes,strings and control codes sekli asagidaki sekil icindir.

Code String “3‘;:,":' Code

-
CT.663.873.241.411,180.604.20& lamp @comner. 30& @.,
FullCodes

Bu kod seklinde olusmus bir doaya alindiginda CAD sekmesinde asagidaki bilgi seklinde
goruntdlenir.
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Gonerd | Coordmates  CAD | Adustmert | Stng | Quelty contrel | Photo Notes |
Pont Symbol | ETLATER -
Coi [a'ru;n: 3
Codes

| Code | srog [ Contrelcode [ aatrtute [ vahe |
L 1] Lwmp cofrer

- EX

A »

= | _ Gor | |

Code Attribute
1 1
P1,660.343,257.340, 1 80,903,lhase station: Hiper H Vert 1 S8.TEXT=""

FullCodes

Bu sekilde bir dosya alindiginda bilgi ekrani asagidaki gibi olur.

Proparties : Point B1

Abidnke [wahse |
HPer Hverl §.77m

Eger dosyada her iki durum da s6z konusu ise her iki secenek de isaretlenir.

[V FulCodes include Code, String and ControlCode
[V FulCodes include Code and Attribute
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Oznitelik bilgisi iceren kod var ise alinacak dosyada ayirici olarak Space kullanmayiniz.Comma
, tab , semicolon ayirici olarak kullanilabilir.

11 Ok tusuna basilarak secilmis olan dosyanin bu ayarlarla alinmasi saglanir.
GPS + Ham datalarin alinmasi
Topcon Tools asagidaki GPS+ ham datalarini alir;

e Standart RINEX dosyalar.

e Kompakt RINEX dosyalar (ya da Hatanaka sikistilimis dosyalarti)
e SP3 hassas efemeris dosyasi

e TPS/JPS Topcon alicilari ile kaydedilmis ham data

e TPD Topcon 6zel formati

Dosyalari almak igin

1- Meniden Job->Import , ya da F3 e basarak, ya da Arag¢ cubugundan Import butonuna
basilir.

2- Format ismi segilir

3- Dosyanin bulundugu klasor segilir

4- Almak icin Open tusuna basilir.

Birden cok dosya secilebilir.

;H Import
Laok irc |224CMerg

ﬂ BLI31703a.tps [ BL432103a.tps B EEIC I
03b.tps P TS NNl | ELa31803b.tps

ELL._'ILI b.tps @&ESEIm.tps EiLEi'ElEiEIE:a.t[:S

| BL231 7038, tps Wi R GAEE T

= BL231803atps = BLE32103a.tps

= BL231803b.tps [ BLE32103d, tps

= BL331703a0ps I E R R

[ BL331803b.tps [ ERETRE e

= BL332103b.tps | ERERDECT AT

= B 431603atps EEEORIEN

File name: |"BL131803b.tps" "BL132103b.tps” "BL231703a.tps" "BL7317035

Format name: | < GFS+ Raw Data File (~tpd~ 770, 776.% 79N~ 77D 503" v
I Advanced options

Open Cancel
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Topcon Tools is dosyasinin Alinmasi

Topcon Tools is dosyasi baska bir is dosyasini icine alinabilir.Ornegin giin giin calisilan
dosyalar isin tamami icin bir araya getirilebilir.

1- Job->Import ya da F3 e basarak ya da Ara¢ cubugundan Import tusuna basilir.
2- Format name olarak Topcon Tools Job segilir.

3- Secilecek dosya bilgisayarda bulunur

4- Import etmek igin Open tusuna basiniz.

i~ Import

Look ir: |Lﬂ-]|:ul:us j ﬂ @

IiBackup
@ adTst.bttp
# PrownTPSkp
AR osic Par, tEp

ﬁ Westand.ttp

File: name: |Rozic Par tp

Farmat name: | Topoaon Tools Job [*tp] j
[ Advanced optiors

Open % Cancel

Alinacak Topcon Tools is dosyasinin ayarlari mevcut dosyanin ayarlarindan farkl ise Override
Job Configuration diyalog penceresi goriintiilenir. ilgili ayarlar bu pencereden segilir.
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&4 Override Job Configuration

OK tusuna basilir.
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Gorlintileme Se¢me ve Filtreleme

Topcon Tools da bir is dosyasi acildiginda , bircok goriintileme secenegi mevcuttur. Noktalar
ve vektorler , tablo seklinde gozlem datalari v.b. bilgiler proses ve dengeleme icin gerekli
editlemelerin kolay ve kullanish yapilabilecegi bir sekilde dizayn edilmistir.

Data Goriintiileme
Topcon Tools datayi editleme, proses ve yénetmek icin ekranlara sahiptir.

e Bilgi penceresi sekmeler icerir. Bunlar; noktalar , gbzlemler, oturumlar, hat islemleri,
yollar, enkesit sablonlari, ylzey , celik serit Ol¢lleri, imaj, stero gorinti , tarama .

e Harita ekrani aktif is icindeki nokta ve hatlari goriintiler.

e GoOzlem penceresi aktif is icindeki gozlemlerdeki zaman 6lgegini gosterir.

e CAD penceresi hatlari, yollari ve ylzeyleri gosterir.Objeler bulunduklari tabakalarda
tanimlanan renk kalinlik ve stillerle gortintilenir.

e 3D penceresi hat islemleri ,ylzeyler ve yollari ti¢ boyutlu resim seklinde gosterir.

e Cod penceresi tim kodlari ve bu kodlardaki 6znitelik bilgilerini gériintdler.

e lLayer penceresi aktif is teki tim tabakalari gorintdler.

Bu pencerelerde kullanilan renk ve semboller Legend penceresinde tanimlanmistir. Her
pencerede arzu edilir ise Legend penceresi o pencerenin Araglar cubugundaki Legend butonu
tiklanarak agilip kapatilabilir. Gorlintliiniin daha verimli kullanilmasina yardimci olur.

Liste Ekrani ( Tabular View)

Gegerli olarak Liste penceresi ana ekranda goériintiilenmektedir.Bu pencereyi agip kapatmak
icin View->Tabular View ya da Ctrl+T ya da araglar gubugunda Tabular View tusu tiklanir.

Liste ekranlari degisik bilgiler igermektedir.

e Points: Nokta numarasi, koordinatlari ve diger nokta bilgilerini gortintiler

e GPS Occupations: Nokta numarasi , anten bilgileri , gozlem siiresi , methodu,
dosyanin PC deki konumu ve 6l¢linin yapildigi Cihazin ID si gérintilenir.

e GPS Observations: Noktadan noktaya nokta isimleri , oturum siresi , hesplanan
vektor ¢coziim parametreleri ve ¢ozimle ilgili diger bilgileri icerir.
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Linework: Kodlari, tabakalari, siralari ve CAD bilgilerini icerir.

Nokta Sekmesi (Points Tab)

Noktaya ait bilgileri icerir.Asagidaki kolonlari icerir.

Icon: Noktaya ait sembol gorintilenir

Name: Noktanin ismi

Point coordinates: is dosyasinda secilmis koordinat sistemine bagli olarak noktanin
koordinatlarini gosterir.

Code: Noktada kullanilan kodu gosterir.

Control: Koordinatinin dengelemede sabit nokta olarak alinip alinmadigi

Note: Kullanici bilgisini gosterir

Photo notes: Her bir noktaya ait kag tane fotograf bilgisi oldugu

Layer: Noktanin tabakasi

Standart deviations: Dengeleme sonrasi standart sapmasi

String and control code:

Combinedscale factor: Grid mesafeyi ylizey mesafeye donistirmek icin uygulanan
Olcek faktori

Convergence: Jeodezik kuzey ile grid kuzey arasindaki acl

* &% Points ]o? &PS Occupations | ¢ Tsobs | @2 Gesobs |

Icon | ame | Latitude | Longitude | Ell Height {m}) | Code | Control Mok | Skd M~
® Bl 475433, 962430 122°33'19.479,., 15,945 reha None

@ HZ 475455, 7317 AN 122933 18,542, .. 37,828 punch Hane

® B3 47UR40, 6664 122533'18,509, 20,152 pk Noine

® B4 47UE42E, 5074 122933'19,005. 41,317 rehar None

® BLS 475427, 40061N 12293351161, 20,682 rehar Mone

® BL6 47540, ME03N 12273322 690, 19,162 rehar None

® BT 4775434, 543820 122°33'23.707... 34,316 bok None ¥
< 3

ilgili kolonun bashgi tiklanarak alfabetik siralama yaptirilabilir.

GPS Occupations Tab

GPS occupations sekmesi GPS datasi var ise ve PP,RTK ya da GIS moduli aktif edilmisse
gorinttlenir. Gorintlilemek icin GPS occupations sekmesi tiklanir.Bu sekme asagidaki

bilgileri igerir ;

Icon: Noktaya ait sembol goriintilenir

Name: Noktanin ismi

Original name: Orijinal gozlem ismi

Antenna type: Goézlem esnasinda kullanilan anten tipi
Antenna height: anten yuksekligi
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e Antenna height method: Anten yikseklik 6lgme sekli (dusey vertical/egik slant)
e Start time and stop time : Oturumun baglama bitis tarih ve saatleri.

e Duration: Oturum suresi

e Method: Gézlem esnasinda kullanilan yontem.

e Antenna height:

GPS Obs Sekmesi

is dosyast icinde statik RTK, GIS modiilii aktifse ve data var ise goriintiilenir. GPS
gozlem bilgileri gorintilenir. Bu sekmede asagidaki bilgiler gérintulenir.

e Icon: Noktaya ait sembol goriintilenir

e Point from, Point to: Bazin baslangic ve bitis noktasi.

e Start time: Es zamanh oturumun ilk epok zamani

e Duration: Vektori olusturan es zamanli oturum siiresi

e Note: Baz igin ayrica bir bilgi var ise o goriintilenir

e Horizantal precisions , Vertical precisions ; Vektér ¢ozimiiniin ongorilen yatay ve
disey duyarlilig

e GPS observations solution compenents; GPS gdzlem ¢6ziim elemanlari

e Method: Olgme metodunu gériintiiler

e Solution type : Vektorin ¢oézimdi icin kullanilan ¢éziim tipini goérintiler.Fixed (tim
tamsayi bilinmezlikleri tam olarak ¢oziilmistir) , float (tamsayi bilinmezlikleri tamsayi
olarak ¢6zulmemistir)

e Orbit: Data henlz proses edilmemis ise yoriinge bilgisini gérintiler yayin, hassas ya
da yoktur. Data proses edilmis ise ¢oziimde kullanilan yoriinge bilgisini gortntuler ,
RTK datasi icin bu bilgi yoktur.

e AutoReject: Gozlemin dengelemede eger sartlara uymuyor ise otomatik olarak
reddedilip reddedilmeme bilgisini gérintiler.

e Adjustment status: Datanin dengelenip dengelenmedigini gosterir.

e Residuals: Baz igin dengeleme diizeltmesini gosterir.

e Epocs: Es zamanli oturum siiresine denk gelen epok sayisini gésterir

e GPS satallites/GLONASS satellites: GPS/GLONASS uydu sayilarini gorintiler.RTK
oOlgllerinde sabit ve gezicinin ortak gordiigl uydu sayilarini, Statik 6lclide es zamanli
Olcldeki ortak uydu sayilarini gosterir.

Statik 6lcu datalarinda ¢6zim elemanlari, duyarliliklar , ¢6ziim tipleri data proses edildikten
sonra goruntulenir.
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=

o Painks l.;;? ZPS Cocupstions ] & TS obs O'? GPS Obs | B, TapeDimensions ]

Icon | Foint From |Point To | Skart Time | Duration | Mok Horizankal Precisi, . | Wertical Precis, . | di () | dE {m} | dE
@, EBase7000001 122 1/24/2003 10:2,,, 0:00:00 0.007 0.004 -1.473 -9,698 -1
&, EBase7000001 123 1/24/2003 10:2... 0:00:00 0.007 0.004 -1.472 -9.642 -1
i, Ea=e7000001  Auka? 124/200% 11:2.. 00000 0.008 n.00s 4 770 -1.%65 r
=3 Ease7000001  Autod 1e4fz2003 112, ddoo 0,008 0.005 -4,593 -5.4E8 L
o, Ease7000001  Autod 1j24fz2003 112, 000 0,007 0.004 -4, 459 -5, 1158 L
i, Ea<e7000001  AutoS 124/200% 11:2...  0:00:00 0.012 0.00a 7508 -85S r
=3 Ease7000001  Autod 1z4f2003 112, ddoo 0011 0.007 -10.862 -2.018 v
< kd

Map View (Harita Penceresi)

Eger is kapatildiginda harita ekrani agik ise o is dosyasi tekrar acgildiginda harita
ekraninda acilir. Harita penceresini agmak ya da kapatmak icin View->Map view
, yada Ctrl+M ya da arac¢ cubugunda Map View tusu tiklanir.

Harita penceresi datayi ve arka plan gorlintisd var ise bu gorintliiyl de enlem
boylam ya da saga kuzey degerleri ile goriintiler.

e Koyu renkte goriintlilenen kenarlar tekrarl bazlari gosterir.

e Yakinlastirma ya da uzaklastirma yapmak icin Mouse sag tus menusi ya
da Mouse tekerlegi kullanilabilir.

e GoOriuntiyd kaydirmak icin Mouse tekerlegine basilir ya da sag tus ile

gelen menuden Pan segcilir ve gorinti ¢ekilerek Mouse ile kaydirilir.

122%35350,0" 122%33'40.0"W 122%353730.0™ 122%33720,0™ 122937100 Longitude
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Harita ekraninda editleme yapmak icin baz ya da nokta Uzerinde Mouse sag tus yapilir ve
Properties segilir.

Occupation View (Gozlem penceresi)

Bu pencere acik iken is dosyasi kapatilir ise tekrar acildiginda bu pencere gérintilenir.
Pencereyi agmak ya da kapatmak icin View->Occupation View , ya da ara¢ cubugundaki
Occupation view tusu tiklanir.

Bu ekran noktanin ve bu noktadaki GPS zamanlarini grafik olarak gosteren bir ekrandir.
Degisik goriintileme opsiyonlari mevcuttur.

e Nokta numarasina gore gosterim
e Aliciya gore gosterim

¢ Noktaya gore uydu cubugu

e Aliciya gore nokta cubugu

Occupations by points secildiginde ekran asagidaki gibidir.

5 Occu pation Yiew

[ Skabic acoupabions
o, K1031c_L1% & —) — == Kincrnatic accupatiors
& K1031c_1104 K1 — —= T 2 Topo occupations
@, K1031c_1104 k2 B — = == ALta topo nccupakions
@ RLD31C_1104 k3 H — 1 I
©, K1031c_1104 k4 F —| ]
@ k1031c_1104 51 & — 1 L 1
@ K103 1104 52 B — [
@, K1031C_1104 53 B —|
@, 11021b_2340 [ —| é
L L
@ 3L.10.2001 3:%0:00 31.10,2001 20000 EPS Time

e Yakinlastirma ya da uzaklastirma yapmak icin Mouse sag tus menisi ya da Mouse
tekerlegi kullanilabilir.

e GOrlintliyl kaydirmak icin Mouse tekerlegine basilir ya da sag tus ile gelen meniden
Pan segilir ve goriinti ¢ekilerek Mouse ile kaydirilir.
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Her bir uyduya ait gézlem sireleri ve epoklari gormek igin + isareti tiklanarak genisletilir.

Kapatmak igin — tusuna basilir.

E Uecupation Vi

Fonts
= Lis_pee = —i-
B 4N -
5 GIE -
a G2
B G2 =it
L BT B4
B Gl
&G0 =+

all =

3. 10,2001 8:50-00

3010, 20070 5-00:00 '.'P'E»Tmllll

CAD View

Bu pencere acik iken is dosyasl kapatilir ise tekrar agildiginda bu pencere goérintilenir.

Pencereyi agmak ya da kapatmak i¢in View->Cad View tiklanir

Cad penceresi hat islemleri , yol datasi , ylzeyler ve bunlara ait noktalarin grafik olarak

gorintilendikleri ekrandir. Asagidaki bilgiler gorintilenir.

e Nokta ve semboll gorintilenir. Eger noktanin sembolli sok ise 6lgme sembolii

kullanilir.

e Hatlar cd ya da tabakasindaki renk ve kalinligi ile goriintilenir.

e Eger hatta kontrol kodu var ise buna bagh olarak yay , dikdortgen ya da ¢oklu dogru

olarak goruntilenir.

e Hat poligon hat olarak secilmis ve kapali bir hat ise ve de dolgu rengi tanimlanmis ise
alan o renkle dolu boyali olarak goriintilenir.

e Raster ve vektor arka plan gorlintlisi goriintilenir.
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Layer (Tabaka) View

Bu pencere acik iken is dosyasi kapatilir ise tekrar acildiginda bu pencere gérintilenir.
Pencereyi agmak ya da kapatmak i¢in View->Layer View tiklanir

Tabaka penceresi tiim tabakalari ve bunlar icin tanimlanmis olan sitilleri gériintiler.Asagidaki

bilgiler gorintilenir;

e Name: tabaka ismi

e Visible : Cad ve 3D goriintide goriintilenip goriintiilenmeme secenegi

e Line style/Line width/Line Color/Point symbol : Cizilme sitilleri

e Note: Kullanici tarafindan yazilmis bir agiklamam var ise

e Fill area : Evet ya da hayir segenegi ile kapali alanlarin boyanmasi segenegi
e Brekline types: Tabakanin tipini gosterir.

Her TT is dosyasi gecerli olarak 0 (sifir) isimli tabaka olusur. Bu tabaka silinemez, yeniden
isimlendirilemez ancak 6zellikleri degistirilebilir. Yeni tabaka olusturulabilir ya da baska bir is
dosyasinda olusturulmus tabaka is dosyasi igine alinabilir.

Yeni tabaka olusturmak igin ;

e Edit->Add->Layers tiklanir , ya da Layer penceresinde Add Layers acilir menisiinde
tiklanir.
e layers combo kutu sitesi acildiginda Mouse sag tus tiklanir ve Add Layer meniden

secilir.

LE——j

W L2 — — Export boDevice, ..

[7——— 2 Expart...

42 1m
Copy Chrl+c
Properties...

Agilan Add Layer penceresinde arzu edilen 6zellikler segilir.
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= Add Layer : Layer New Layer

X

= Add Layer : Layer New Layer E|g_\|

Kullanici herhangi bir tabakay aktif yapabilir. Ara¢ cubugundaki acilir tabaka listesinde daima

aktif tabaka goriintilenir.

v Ll —

Codes (Kod) View

Bu pencere acik iken is dosyasi kapatilir ise tekrar acildiginda bu pencere gorintilenir.

Pencereyi agmak ya da kapatmak icin View->Codes ya da ara¢ ¢ubuguna Code List tusu

tiklanir

Kod penceresi is dosyasindaki kodlari ve bu kodlar icinde tanimlanmis olan 6znitelik bilgilerini

goruntuler.

e Kodlar igin sol pencere;

o
6]
(o]

Icon: Kodun sembolii
Code: Kodun ismi
Layer: Kod i¢in kullanilan tabaka ismi

e Oznitelik bilgileri icin sag pencere;

(o]

(o]
o
o

Icon: Ozniteligin sembolii

Name: ismi

Default value: Noktaya bu 6znitelik verilirken gecerli olarak gelecek deger
Type: Girilecek degerin tipi (Text, tam say;,meni v.b.)
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General | Plotting styles | fre. General ] Plotting styvles Area |
Name e = Add Layer : Layer New Layer @ Fill &rea |No ﬂ
Visible Genersl  Plotting styles \ Area | Yes

Line Style |
Mot
© Lnewidh [ 1p  ————
Breakhne Type  |&uto Color " |I
Point Symbol .
0K Cancel OK Cancel
]
0K Cancel | | |




Codes : C:\Documents and Settings\PBelikoviTopconTools\Jobs\Linework test.tip Bﬁ||g|

Layer | *| Icon Aktribute Name Default Value Type |
1 Line_L2 12] Attributel Integer
2 0 |ab] Attribute_Text1 Text

3 Line_ L1
for_points  Poink_L2

Goruntii Seceneklerinin Ayarlanmasi

Liste (Tabular) ekrani , Harita ekrani ve Goézlem ekraninin goérintileme secenekleri
mevcuttur ve bu pencerelerde hangi 06zelliklerin gorintilenip gorintilenmeyecegi bu
segeneklerden kolaylikla segilebilir.

Harita Ekran Goriintiileme Segenekleri

1- Harita ekraninda bos bir yerde Mouse sag tusu tiklandiginda acilan meniiden Options
tiklanir.
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x4 Map View Options A Map View Options

Window l Labels | Selection || window Labels | Sdection | Qacc |

v Show grid Static points Finematic poits
[~ Show legend Show ch map Show on map
[+ Show Ellipzes v Mame [ Mame
v Show B ackaground Map [ Code [ Code
[ Height [ Height
Show on cursar Show on cursor
[ Mame [ Mame
v Code ¥ Code
[ Height [ Height
Shaow on stahus bar Show on status bar
[ Marne [ Mame

i~ Map View Options i~ Map View Options

Window ] Labels  Selection Windois ] Lal:nels] Selection QAQC l

[ Show distznce [v Show QAQC infermation in boalip
v Show azirmth
[ Show dirmensions:

[ Show area size

(0] Cancel Ok Canicel

Degisiklik yapilan sekme sag altinda Apply tusuna basilarak is dosyasina uygulanir. Sekmeler;

2- Window sekmesinde
a. Show grid: Koordinat gridinin goérintilenmesi
b. Show legend: Liste ve harita ekraninda kullanilan semboller ve bunlarin ne
anlama geldiklerinin bulundugu lejant penceresini agip kapatir
c. Show elips: Proses edilmis bazlar ve dengelenmis noktalara ait hata elipsini
goster ya da kapat

d. Show bacround Map: Arka plan goriintlisii eklenmis ise bunun ag ya da kapat
segenegi
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3- Labels sekmesinde; Statik ve kinematik noktalar igin goriintiileme oOzelikleri segilir ve
Apply tusuna basilir.
a. Name: Nokta isminin secildiginde goriintilenme secenegi
b. Code: Nokta kodunun var ise goriintiilenme segenegi
c. Height : Noktanin yiksekliginin goriintilenme secenegi
4- Selections sekmesinde:
a. Show distance:Eger kullanici bir dikdortgen c¢izer ise koseleri arasindaki
mesafenin durum cubugunda goériintilenme secenegi
b. Show azimut: Eger kullanici bir dikdortgen cizer ise baslangic kosesi ile bitis
kosesi arasindaki azimut un durum cubugunda gorintilenme secenegi

L |

L2 Map View

4441100 —

Y

Distance: 145,795 m; Azimuth: 56°12'50,5165" Meters | DMS | Grid

c. Show dimension: Eger kullanici bir dikdortgen ¢izer ise dikdértgenin uzunluk
ve yuksekliginin durum cubugunda gorintilenme secenegi

d. Show area: Eger kullanici bir dikdortgen cizer ise dikdortgenin alaninin durum
¢ubugunda goérintilenme segenegi

Morthirg, 1
Meters |

4441150 —

4441100 —

L

Dimensiors: 132,147 m x 58,802 m; Area) 777049 sq. m Meters | DMS =i
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5- QAQC (Quality Analyses QualityControl ) sekmesinde istenilirse kalite kontrol kriterini
gecememis degerler Mouse ile lizerine gelindiginde gorintiilenmesi segenegi

1122000 —

SAMAN-TAMBOROMN, 17,11,2005 17:33:00 - Faled ko matkch the desred precizion

w

a7z00a 673000 a7 4000 6750C

6- OK tusuna basilarak ayarlarin kaydedilmesi saglanir ve diyalog penceresi kapatilmis

olur.

Occupations (G6zlem) Penceresi Goriintiileme Seg¢enekleri

Occupation goriintiileme secenekleri zaman 6lgegini , sembol tablosunun , secilen gézlemin

QC kriterini gegememis ise goriintilenecek mesaji ile ilgili segenekleri igerir.

1- Occupation penceresinde bos bir yerde sag Mouse tiklamasi ile agilan meniden

Options ya da View->Occupation View Options tiklanir.

2- Show sekmesinde

a.

Show grid: Occupation penceresinde GPS zaman Olgeginin gorintilenip
gorintilenmeyecegi

Show legend: Sembol acgiklamalarini igeren tablonun gorintilenip

goruntilenmeyecegi secilir.Secim gecerli olmasi icin Apply tusuna basilir.

?IX

o~ Occupation View Options

Show | Occupation Wiew | QAQC |

v Show grid
[ Show legend

oK
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3- Occupation sekmesinde gozlemlerin noktaya ya da datay! toplayan aliciya gére mi
siralanacagi segilir.

x4 Occupation View Options

Show Occupation Yiew | QAQcC |

Dizplay Mode

" Show occupations by receivers
*+ Show occupations by points

DK Cancel ‘

4- QAQC (Quality Analyses QualityControl ) sekmesinde iatenilirse kalite kontrol kriterini
gecememis degerler Mouse ile lizerine gelindiginde gorintilenmesi secenegi

e

«A Occupation View Options

Show | Occupation view — QAQC |

v Show QAGDC information in tooltip

BB Occupalion View

:r:‘-n |1:.i-I-n'1"i'\"Ifﬁ|.r': _ﬁ.u'd-'." Wl 21, ‘ﬂhh'\ adireream |l7\.l;i||n lrms low hmrleI (o [ 1Y I:-I:ln.nH-.r r:-m.m!l

5- OK tusuna basilarak ayarlarin kaydedilmesi saglanir ve diyalog penceresi kapatilmis
olur.

CAD Penceresi Goriintiileme Segenekleri

Segenekler koordinat gridinin gorintlilenmesi , arka plan haritasinin uygulanmasi ,
gorintilenecek noktanin etiketlenmesi segenekleri vardir.

1- CAD penceresinde bos bir yerde sag Mouse tiklamasi ile agilan mentiden Options
tiklanir.
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;;1 Oplwns

B Show grd

Windaw | Labels | Selection |

[ St Bk ground Map

&4 Options

Shate peants
Lo on mag

» Mame

[~ Code

[ Hesghl
Sheaw On CLEl

[ Mame

| Code

[~ Hasigh
Show on sabus bar

[ Mo

W Heaghi

window  Labels | Ssleence |

ed Opthoms
Window | Labek  Selection |

W St distancn
[ Sl soweith
[ Gl dhmenasns
[ Shiwe sina woe

Cancel

IJT

1- Window sekmesinde
a. Show grid: Koordinat gridinin goérintilenmesi
b. Show bakground Map: Arka plan gorintlisi eklenmis ise bunun a¢ ya da

2- Labels sekmesinde; goriintlileme o6zelikleri secilir ve Apply tusuna basilir.

kapat secenegi

a. Name: Nokta isminin segildiginde gorintilenme secenegi

b. Code: Nokta kodunun var ise gérintiilenme segcenegi

c. Height : Noktanin yuksekliginin gérintilenme segenegi
3- Selections sekmesinde:

a. Show distance:Eger kullanici bir dikdortgen cizer ise koseleri arasindaki
mesafenin durum ¢ubugunda goériintilenme segenegi
b. Show azimut: Eger kullanici bir dikdortgen cizer ise baslangic kosesi ile bitis

kosesi arasindaki azimut un durum gubugunda gorintilenme secgenegi
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Distance; 205,007 m; Azimuth: 51°22'25.1017" Meters | DMS  Ground

Show dimension: Eger kullanici bir dikdortgen cizer ise dikdértgenin uzunluk
ve ylksekliginin durum gubugunda goriintilenme segenegi

Show area: Eger kullanici bir dikdértgen gizer ise dikdértgenin alaninin  durum
cubugunda goriintiilenme secenegi

CAD View

Dimensions: §1.229m x 78,93 m; Area: 6411 5. m

Meters | DMS  @round
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Liste (Tabular View) Ekraninda Sekme (Tab) Sec¢enekleri

Sekmelerde goriintilenecek kolonlar ve bunlarin dizilisleri ile ilgili secimler yapilabilmektedir.

1- Tabular View penceresinde bos bir yerde sag Mouse tiklamasi ile agilan meniden
Options ya da View->Tabular View Options tiklanir.

i Dptions 3 E]
Display l
Show Colurns
Aveailable columnnz Selected columnz
Cambired grid-» ground scale factc lcoh
Corwergence Mame
> Latituds'Mathing Move Lip
LongitudehEazting
EllLHEElewation
Code .
Cantrol "2 Dptions
Moke .
Std Dev n Display |
e StdDev e Show coluninz in right pane
Std Devu f
Available columns Selected colunng
Harizamtal Digtanc lean A
Wertical ngle #
Wertical Distance >3 Faitt From Mave Up
ok k Caticel OFzet Alang Faint Ta
Ofzet dHt Fieflector Heigh
Ofzet dorozs Azimuth
Offzet Tupe Horizantal Ciel
HDizst Residual Slope Diztance
\}'.n'-'lrl'ngle Rgsid_lal Fanith Angle
WDist Residual e Date Mese B
MNate
Code
Type hdt
Show columns in left pans
Avallable columne Selected columng
lcan
#
>3 Fairt MNarne borve Lip
Instrurrent H=ight
Inztrurrent Tppe
ak & | Cancel ‘ ‘

Gorlinttlenecek secenekler sag ekrandadir. Goriintiilenmesin istenilenler segilir ve << tusu
ile sola ya da goriintilenmesi istenen secenekler sol pencerede secilip >> tusu ile sag
pencereye aktarilir. Sag pencerede Move up ve Move Down tuslari ile se¢cimin siralamasi
asagl ya da yukari olacak sekilde degistirilebilir.



Datalarin Disari Verilmesi

Topcon Tools diger programlarin datayl okumasi i¢in asagidaki dosya tiirli ve formatlarinda

datayi disari verebilmektedir.

* Code Library files

DBF Code Library (*.dbf)

TDD Code Library (*.tdd)
XML Code Library (*.xml)

Coordinate files
APA Coordinates (*.zk)
CR-5 Files (*.CR5)
Custom Text Format files (*.%)
FC-4 Points (*.xvz; *.fcd; *.pnt)
FC-5 Points (*.xyz; *.fc5; *.pnt)
GTS-210/310-10 Points (*.xyz;
. pnt)
GTS-210/310-12 Points (*.xvz:
. pnt)
GTS-7 Points (*.xyz; *.pnt)
Land XML Points (*.xml)
Name E.N,Z.Code (*.csv)
Name,Lat,Lon Ht,Code (*.csv)
Name N.E.Z.Code (*.csv)
SIMA Coordinates (*.sim)
Topcon Japan Coordinates (*.zt)
Topcon XML Points (*.xml)

TopSurv Coordinates (*.txt)

Cut Sheet files
Cut Sheet Standard (*.css)
Cus Sheet User Defined (*.csu)
GPS5+ Raw Data Files
Compact RINEX (*.77D; *.77G;
. TIN)
RINEX (*.770; *.77G; *.77N)
TPD (*.tpd)

* Localization Files (*.gc3)
Road Files
CLIP (*.plt)
ISPOL (*.ali)
LandXML Roads (*.xml)
TDS RDS5 (*.rd5)
Topcon MC (*.rd3)
Topcon SSS (*.hal)
Topcon XML Roads (*.xml)
TopSURYV (*.thl)
VGP (*.vgp)
* Topcon Tools Jobs (*.ttp)
* Topcon XML Files (*.xml)
* TopSURYV PC Job Files (*.tlsv)

62



Design Files * TS Obs Files

DWG (*.dwg) Custom Text Format (*.%)
DXF (*.dxf) FC-5 Raw (*.raw; *.dat; *.fc5)
Land XML (*.xml) GTS-210_310 Raw (*.raw; *.dat;
TN3 Surface (*.tn3)  gts *.gt6)

+ Field Scan Data files (*.fsc) GT5-6 No Station Raw (*.raw;

« GIS Files *.dat; *.gts; *.gts0; *.gt0)
Shape (*.shp) GTS-6 Raw (*.raw: *.dat; *. gts;

*.gts6; *.gth)
GTS5-7 Raw (*.raw; *.dat; *.gts;
FatsTy FgtT)

GPS Obs files
BlueBook Sheet (*.gfl, *.bfl)

Custom Text Format (*.%) GTS-7+ Raw (*.raw; *.dat; *.gts:
LandXML GPS Obs (*.xml) * gisT: *.gt7)

O files (O*.%) LandXML TS Obs (*.xml)
Topcon RTK Vectors (*.tvf) Topcon Japan TS Obs (*.01t)
Topcon Vectors (*.tvf) Topcon XML TS Obs (*.xml)
Topcon XML GPS Obs (*.xml) + X-Section Template files

TDS TP5 (*.tp3)
Topcon 555 (*.xtl)
Topcon XML X-Section
Templates (*.xml)
TopSURV (*.xst)

DWG , DXF ve Shape dosya tirleri CAD ve GIS yazilimlarina veri géndermek icin kullanilan
genel formatlardir. DWG ve DXF Autocad yaziliminin , Shape dosya formati da Arcinfo
yazilimlarinin formatlaridir.O dosyalari Ashtech markasinin dosya formatidir .

Datanin Verilmesi

1- Secilen formatta datay! vermek icin

a. Job->Export ya da F4 ya da araclar cubugundan Export to File tusuna basilir.
2- Dosyanin kaydedilecegi klasor segilir
3- Kaydedilecek format ismi segilir.
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&4 Export @E|
Savein C3Data -

¥ Coordinate File (*.bxt;*, CRS;* cov; ¥ sovz;® fod; ™, pnk; . FcS* )
+ Cut Sheet File (*.csu;™.css)
Feature File (*.kdd)
+ GIS File (*.dwig;™* xml;*.shp;* . dx«f)
+ GPS Vector File (0%, *;*.kvF)
¥ £ GPS+ Raw Data File (*.tpd;*,220;%,22G;*,72N;*,77D)
Localization Files (*.GC3)
Topcon Tools Job (*.ktp)
= Topcon #ML File (* xml)
TopSURY Database File (™ tsy)
+ =7 TS Raw Data File {*,raw;* dat;* . fcS;*.gts; *, gté;*, gtsé; * . gts7;* gt 7)

File name:

Format name; ASCI ATSW files [ twt)
[ Advanced ophons

Cancel

4- Eger isteniyor ise daha detayli verme secgenekleri icin Advanced options panel agllir.
a. Verilen dosya formatina goére projeksiyon , datum , koordinat tipi , grid-
>ground transformasyon parametreleri ve geoid model secilir.
b. Ortometrik ylkseklik kullanmigsaniz Orthometric Height segilir.
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<~ Export @E
Save m; |.|_I Data _j __‘_J[:_Fi

File: name: |Rosic Par - Processed0504

Format name: [ ASCII /TSV/ files [*1x1) ~

iy

Projection |72 Nane =] custon
Linear Unit |USFeet |
Geoid ] =l GeodsList.. |
W Orthometiic Height '
Coordinate type |Gnd

Save Cancel

@NOT: Eger gelismis secenekler secilmez ise Topcon Tools aktif is dosyasindaki ayarlar
ne ise o ayarlara gore dosyay! verir.

5- Kaydetmek istediginiz ismi yazin ve Save tusuna basilir.

Topcon Tools dan Topcon Control Unitelerine data verilmesi islemi Toplink Kullanim
kilavuzunda anlatilmaktadir.
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PROSES , DENGELEME , LOKALIZASYON

GPS ham datasi ile ¢alisirken vektorlerin ve yaklasik nokta koordinatlarinin hesaplanmasi igin
data oncelikle proses yapilmalidir.Hassas nokta koordinati ihtiyac duyulan Haritacilik
calismalarinda bu elde edilen yaklasik koordinatlar istenilen hassasiyeti saglamaz. Nokta
koordinat hassasiyetinin arttirilmasi icin dengeleme yapilmalidir.

Dengeleme fonksiyonu Total station datalari ile GPS 6l¢li datalarini kombine ederek ag
dengelemesi yapabilir ve RTK 6lcl datalari tekrar hesaplanabilir.

GPS koordinatlari (WGS84) lokalizasyon islemi ile elde edilen dénisim parametresi
yardimiyla istenilen projeksiyona donusturulebilir.

Proses ve Dengeleme Parametrelerinin Ayarlanmasi

1- Proses ve dengeleme parametrelerini ayarlamak igin asagidaki islemleri yapin
a. Process->Process properties i tiklayin. Process properties diyalog kutusu
gorintulenir.
b. Job->Job configuration u tiklayin sonra sol boliimde Processi secin

Process paneldeki Job Configliration diyalog kutusu ve process properties diyalog kutusu ayni
parametreleri gorintiler.

2- Adjustment sekmesinde asagidaki parametreleri segin;
a. Dengeleme islemindeki gvenilirlik seviyesi:
b. Kdéde gozlem datalarinin reddedilme kriteri. Default olan deger kalite kontrol e
gore (By quality Control)
c. Dengeleme yapilmadan Once yapilacak testler secilir. Default deger tim
testlerin yapilmasidir.

Yukaridaki boélimde anlatilan sekilde gerekli secimler ve karsilastirma kriter degerleri
girilmelidir.

Nokta Datasinin Aktif ./Aktif degil olarak segilmesi
Liste , Harita yada Gozlem penceresinde bu islem yapilabilir.

e Tek ya da birden fazla datayi se¢in ve muse sag tus da acilan meniide Enable (aktif) ya
da Disable (aktif degil) secin
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e Tek ya da birden fazla datayr secin menili ¢ubugundan Edit->Enable ya da Edit-
>Disable secin

e Tek ya da birden fazla datayl secin properties diyalog kutusunu acin General
sekmesinden seciminizi yapin.

Aktif degil yapilan data tiim pencerelerde soluk gri olarak gorintilenir.

Ol¢ii Epoklarinin Aktif / Aktif degil yapilmasi

Occupation (Gozlem ) ekraninda her bir izlenen uydu gorintilenmektedir. Gelismis modiil
kullanicilari proses edilecek datayi bozabilecek goézlem epoklarini aktif ya da aktif degil olarak
secebilirler ve daha iyi sonuglar elde edebilirler.

+/- tuslarina basarak tim uydulara ait verinin gértintilenmesi saglanir.

=] s .
&= Occupation View

B : egend »
¥ — - ! ; Occupations
e —. ===
% R2Z3 — i == Kinematic accupatiorg
% R21 - * : B Topo occupations
e ——1 —
% 531 7_|7 —— === Auto topo occupationt———
% G25 ﬁ |———
% G20 — - p—
% G15 | —
T ——————— E—
| — : — 2 B .

1 L 1
LI L I T 1 T T I T 1 | T F % | =¥ 1 I ST P Vi | I T T T T l | [ A | T I ! S

10/27/2003 12:30:00 AM 10/27/2003 1:00:00 AM 10/27/2003 1:30:00 AM  GPS Time

1- Tek bir epok da aktif/aktif degil yapabilmek igin gériintli ekranini biyutiin

2- Mouse ile kare gizerek seg¢im yapabilirsiniz.Se¢cim yaptiktan sonra Mouse sag tusa
basarak enable/disable tiklayabilirsiniz.

3- Segime epok ekleme yapmak ya da ¢ikartmak igin CTRL tusu basiliyken segim yaparak
ekleme cikartma yapabilirsiniz.

68



Points

% G5 —

Paints

% 525 )
% G523

% GZ3 ! ]

% a2 —*
% G20 ——
10F27/2003 12:20:00 &M

10/27/2003 12:20:00 AM

Points
¥ G5 i i
Enable Epochs
% c2 |
T T T T T T T T | T T T T T
102702003 12:20:00 &M

Aktif degil olarak secilmis bolimler taranarak gortntdlenir.

Proses

Proses islemi tiklandiginda Quality control ve proses parametreleri ekranlarinda girilen
degerler goz online alinarak bazlar proses edilir. Bu ayarlarin detaylari ilgili bolimde
incelenebilir.

Tiim GPS Olgiilerinin Proses Edilmesi
is dosyasindaki tiim vektérleri proses etmek igin;

e Process->GPS+ PostProcessing tusu tiklanir
e Klavyeden F7 tusuna basilabilir
e GPS+ PostProcessing tusuna basilir.

|
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Secilen Olgiilerin Proses Edilmesi

1- Proses edilecek olgliler Harita penceresi ya da GPS gbézlem penceresinden segilir.
2- GPS Obs sekmesinde secimin Uzerinde Mouse sag tus tiklandiginda acgillan menide
GPS+ PostProcessing tiklanir.

«” Foints ]-:;'fj GFS Occupations ] <3 Ts0hbs dﬂ; GP5 Obs l

Foint From | Fioint To | Stark Time | Duration
o« ETNNN ... . 07... QiD:1S
« ETEINNN 2Z... 0:10:00
o ETUIEIN - Crbt? 38, 08115
& [ Copy CorHC 47 0ses
o+ FENI - el et ootis
& BL3 Disable 09... 0:05:00
& B4 14... 1115
£ P54 PostProcessing

Properties

Cptions. ..

Sonuglarin Algilanmasi
Lejant penceresi (legend) kullanilan ikonlarin ve renklerin ne anlama geldigini aciklamaktadir.

Map (harita) ekraninda, proses edilmis kenarlar parlak vyesil ve kirmizi renkte
goruntilenebilir. Eger proses sonucu yatay ve disey duyarhlik is konfiglirasyonunda girilen
degerlerden koéti ise kenarlar kirmizi gérintilenir.

Liste ekraninda dengeleme ve proses bilgileri asagidaki kolonlari igerir.
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e Baz ¢6zimine ait yatay ve diisey duyarlilik

e Vektorlerdeki kullanilan ¢6ziim tipi Fix ( tim tamsayi bilinmezlikleri ¢6ziilmis ) Float (

tiim tamsayi bilinmezlikleri tam sayi olarak ¢6zilmemis)

&” Foints |Q®

s

GF3 Occupations ] < T3 obs O@; GPS Obs | B, Tap=[f

jnensions l

« O
@,

Foink From Poink To | Start Time | Duration | Moke Horizontel Precision {m) | Wertical Precision {m} | dn {r
& EN e FL8f2005 1:22...  0:10:00 Bei ore
& [EN .- 3/19/2003 1:38.., O:06:15

3/19/2003 1:12... 0:06:45

& B4 " Foirks | @ oPSoccupatons | < TSObs 4% GPSObs | B, Tepe Dimensions |
&, BLY | [ ation | fote | Horizonkal Predsion {m) | Wertical Precision {m) | an () | de (m}) | du {m}) | Mathod
£ 07, 0:10:15 0.002 0.003 -0.079 14,865 0.126 PP

22, 001000 0,007 0,013 -0, 415 15,006 -1.011 FP

138, 0:06:15 0,005 0.016 -586.420 15.015 -1.029 PP

HE. 0G4S 0.007 0,013 -G, 351 0,156 -0,910 PP

21, 00415 0,007 0.013 -56.3%4 0,144 0,931 PP

0%, 0:05:00 FF

44, 011115 After PP

4 ¥

|

Baz Proses Modlari

Topcon Tools baz uzunluklarina goére statik 6l¢li datalarinin prosesinde asagidaki yontemleri

kullanir.

e VLBL

40km den

uzun bazlarin ¢dziimiinde kullanilir. iyonosfer ve troposfer

dizeltmelerinde Ugll fazlar kullanilir. C6zim tipinde “lono Free” gérintulenir.
e Widelane
kolonunda “Fixed , Wide Lane” ya da “Float, Wide Lane” yazacaktir.

30km ile 40km arasinda bazlarin ¢6zimiinde kullanilir. Cozim tipi

e L1&L2c : 10km ile 30km arasindaki bazlarda kullanilir. C6zim tipi kolonunda “Fixed ,

lono Free” ya da “Float, lono Free” yazacaktir.

e L1&L2 : 10km den kugik bazlarda kullanilir ve ¢6ziim kolonunda “Fix” ya da “Float”

yazacaktir.

Dengeleme

Totaal station datalari, GPS datalari ve Dijital nivo datalari Topcon Tools icinde birlikte ya da

ayri ayri serbest ya da dayali dengelenebilir. Dayali dengeleme sabit kontrol noktalarina
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dayali olarak yapilir. Serbest dengelemede ise programin rastgele sectigi bir noktadan yapilir.
Dengeleme hakkinda bazi bilgiler asagidadir ;

e GPS datalarinin dengelemesi segilmis olan datumda yapilir , total station gézlemleri
ortalama dinya yaricapl kirede yapilir. Her iki dengeleme de is dosyasindaki geoid
parametrelerini kullanacaktir.

e Ag dengelenmeden once GPS/TS/DL nokta koordinatlari ilgili datalardan tekrar
hesaplanir

e Topcon Tools dizlem koordinatlari ve onlarin yikseklikleri ile degisik dengelemeler
yapabilir.

e Gelismis modul kullanildiginda agin boyutuna gore 1D, 2D, 3D ya da AUTO segilebilir.

@ A& dengelemeden 6nce data proses edilmelidir.

AgI dengelemeden 6nce yazilim agl analiz eder ve sonra dengeleme islemini gergeklestirir.
Datayi dengelemek igin ;

e Process->Adjustment
e Klavyeden F8 tusu
e Buton cubugunda Adjust Network tusu kullanilabilir.

Ag dengelemeye baslandiginda analiz edilir ve Adjustment diagnostic (dengeleme hata
tanima ) diyalog kutusu gorintilenir. Bu diyalog kutusu hassas agi dengelenmesi ile ilgili bazi
bilgileri gorintilemektedir.

Continue tusuna basilarak datada herhangi bir degisiklik yapilmadan devam edilir.

e Stop tusu ile dengeleme islemi durdurulur

e Link tiklanarak ilgili data editlenebilir. Dengeleme islemine devam edilecek ise Restart
tusuna basilir

e Save preliminary coordinates tusu tiklanarak ilk hesap koordinatlari gériintilenir.
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:—H Adjustment Diagnostic

Subnetwork master BEGGE, 2 BHDS, s0 8OWD, . (Horz + Ver)
Mo Horizontal Control

Yert Control Points: 1

Will not be done Honzontal Adjustment

Save Preliminany Coordinates

Process properties diyalog kutusu ve Adjustment sekmesi dengeleme isleminde
gercgeklestirilecek testlerin segildigi yerdir.

"2 Process properties

Adjustment | TS-Computations | GPS+ PostProcess |
Corfidence Level

" 88%

(¢ 95%

(" 99%

Aejection Cotenon

2 Byﬂu#yﬂmtml

Analyse Aepeated Observabons
v Analyse |denbcal Ponts
Control Tee Analysis

Dengeleme Testi :Vektor kordinatlari kontrolii

Bu test baz koordinatlari ile bazin bitis noktasi koordinatlarini karsilastirir.Kordinatlar
arasindaki fark 1000metreden fazla ise islem durur ve Adjustment Diagnostic diyalog kutusu
goruntdlenir.
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A Adjustment Diagnostic

cubnetwork ET, CT, OT, ... Horz + Yert)

Mo Wertical and Honzontal Control

Observations with Big Misclosure

Name Type GPS misclosure(m) SD misclosure(m) HA misclosure(")

(OTTad - DRANE TS babR1.72

Adjustment CANNOT continue without changing

| Cancel Save Prelirminary Coordinates

Bazi gozlemlerde hata oldugunda dengeleme islemi devam edemez.

1- Adjustment diagnostic penceresindeki link tiklanarak hatali goézlem datasina
yonlenir.Harita ekraninda gézlem datasi gorintilenir.

2- Gerekli editlemeler yapilir.

3- Restart tusuna basilarak dengeleme islemine devam edilir.

Dengelem Testi : Tekrarl gozlemlerin Analizi

Baslama ve bitis isimleri ayni olan gozlemler tekrarli gbézlem olarak degerlendirilir ve
ortalamasi alinir. (Ornegin N1-N2 ve N2-N1 tekrarl gdzlemdir ) Ortalama tekrarh gézlemlerin
yerine degerlendirilir. Test Quality Control sekmesinde girilmis olan degere gecer ya da
gecemedigi icin hatali olur.

e Ortalama ile tekrarli 6lglilerden her birinin arasindaki fark Job Configuratin daki girili
degerden kiiclik ise bu tekrarli gozlem testi gecer

e Ortalama ile tekrarli 6lglilerden her birinin arasindaki fark Job Configuratin daki girili
degerden blyik ise bu tekrarlh gozlem testi gecemez ve dengeleme islemi durur.
Adjustment Diagnostic diyalog kutusu gortntilenir.
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A Adjustment Diagnostic

=ubnetwork g0 SCWWD, 51 4160, master BBGE, ... (Horz +%ert)
Haorz Control Points: 1, %ert Contral Paoinis: 1

Suspected Repeated GPS Observations

Name Type Dev N{m) Dev E{m) Dewv H{m) y
1 MB0-g2 GHDS GPS 0.B63 0.250 0.295
s1 MED-s2 BHDS GRS 0.433 0.477 0.148
s1 MMEB0-52 BHDS GRS 0.429 0.473 0.150
=
Continue Cancel Sawve Prelimnarny Coardinates

Dengeleme islemi datada gerekli editlemeler yapildiktan sonra devam ettirilebilir ya da

tekrar baslatilabilir.

CER

Tabudar vicws

i

o” Punis | g & dcopetions & s ok I
L] ¥ pwesrem | PeeTo | st Temm | pmon o~
I N & sl _sted £2_0HDS 04092001 | 304:00 Ooirsnz
beaths e [} ® 31 4180 2 s 04,09.2007 13405 0102230
' | 1 LS L] B 4.00.2001 13:11:38 o
f |I Y S1_sih 04,09 70807 TRETNSS
| ] A Y il NIkE REMN 2 L
| | Y
| i #4060
PI795.5N = R
| amnanlet ane 0 ¢ BEGG prz + Vel
Harz Contial Poinla 1, Vel Contral Pamie |
L | e s o l’ i L L] T — -
W Suspected Repeated GPS Obstrvations
Marne Type l Dev Him) | DevEjns) | Dov Hjm)
al 416052 8405 | GPS | 0ee3 0950 0 2%
gl 416002 BHDE | GPS | D433 047 0148
- . - 4
Sl AIEC2 BHDS | GPS | D48 04 150
-

Dengeleme Testi : Es nokta Testi

Bu test is icindeki tim noktalarin koordinat farklarini kontrol eder.Testin basarili ya da
basarisiz olmasi Job Configliration penceresinde Point Precision da girilmis olan degerden

kiictik yada bliylk olmasina goredir.

e Koordinat farki yatay ve diisey duyarlik igin ayarlarda girilen degerden kiglk ise testi
gecer.
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e Koordinat farki yatay ve diisey duyarlik icin ayarlarda girilen degerden byl ise testi
gecemez ve dengeleme durdurularak Adjustment Diagnostik diyalok penceresi
goruntilenir.

4 Adjustment Diagnostic

cubnetwork base, C1128a_EA9C, lagl1d8a_IUPS, .. (Horz + Yert)
Mo “ertical and Harizontal Control

Identical Points
Group of close points: C1128aEAAC lag1128a_ [UPS, Od_B1128a 5Wilk

Continue Cancel Save Preliminary Coordinates

Gerekli dizeltme yapildiktan sonra isleme devam edilebilir ya da dengeleme islemi tekrar

baslatilabilir.

Dengeleme Testi : Agin Analizi

Bu test agdaki elemanlar arasinda kopukluk ya da eksik baglanti olup olmadigini kontrol
eder.Sadece TS Olglleri igin ¢alisir , tamamlanmamis agl ya da mesafe 6lglsiini kontrol
eder.Bu sekilde bir durum tespit edilirse islem durur ve Adjustment Diagnostik diyalog
penceresi gorintilenir.

Eger agda kontrol noktasi yok ise serbest dengeleme gerceklestirilir.

4 Adjustment Diagnostic E|

.S
Subnetworks Count: {Horz+Vert): 3 i
Subnetwork A1128a_ X4, C1128a_EAIC, B1128a WWIC (Horz + Yerd)
Haorz Contral Paoints: 1, Yert Cantral Foints: 1
cubnetwork Od_AT1280 WS1S, Od B1128a SWJk log1128a 96GWY. .. (Horz +
“ert)
Mo %erticsl and Horizontal Contraol
Subnetwork HiPerA1128a 0515, log1128a_ IUPS, logl128a LESYY (Harz + Yert)
Mo “ertical and Honzontal Cantrol —
st
Contirue LCancel Save Freliminary Coordnates

Gerekli dizeltme yapildiktan sonra isleme devam edilebilir ya da dengeleme islemi tekrar
baslatilabilir.
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Dengeleme Testi: Diisey ve Yatay Kontrol Noktasi Testi

Eger is dosyasinda kontrol noktasi var ise bu analiz kontrol noktasinin disey ve yatay

koordinatlarinin olup olmadigini kontrol eder.

e Kontrol noktasinin sadece disey koordinati var ise dengeleme islemi durur ve
Adjustment Diagnostic penceresi goriintilenir. Continiu tusu tiklanirsa sadece disey

kontrol koordinatlari ile diiseyde dengeleme yapilir.

4 Adjustment Diagnostic

cubnetwork: s SO0 =1 4160, master BBGE. . (Harz + Yert)

Mo Haorizaontal Contral
Yert Control Points: 1
Will not be done Horizantal Adjustment

|

53 |

Cantinwe Carcel Save Preliminary Coordinates

e Kontrol noktasinin sadece yatay koordinati var ise dengeleme islemi durur ve
Adjustment Diagnostic penceresi gorintiilenir. Continiu tusu tiklanirsa sadece yatay

kontrol koordinatlari ile yatayda dengeleme yapilir

4 Adjustment Diagnostic

cubnetwork s BOWH, 51 4160, master BBSG .. Horz + Vert)

Mo “ertical Control
Horz Contral Foints: 1
Wl ot be done “ertical Adjustment

54

< | 2

ContinLe Cancel Save Prelimnary Coordinates

Dengeleme Testi: Kontrol Noktalarinin Uyusum Testi
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is dosyasinda yatay ve diisey kontrol icin birden fazla kontrol noktasi var ise test kontrol
noktalarinin hassasiyetini kontrol eder. Kontrol tie analizi kontrol noktasi koordinatlari ile
oOlglilerden hesaplanan yaklasik koordinatlari kontrol eder.

Process propetries diyalog kutusunda Dengeleme sekmesinde “Control Tie Analysis” testinin
dengeleme sirasinda yapilmasi ya da yapilmamasi enable/disable yapilabilir.
Menlgubugundaki Job->Job configlration->Quality Qontrol sayfasinda girilmis olan degere
gore testi gecer ya da gecemez.

e Fark degerleri kalite kontrol sekmesinde girilen yatay ve diisey duyarlk degerinden
kiiclkse testi gecer.

e Fark degerleri kalite kontrol sekmesinde girilen yatay ve diisey duyarlk degerinden
bilylkse test durur ve Control Tie Analysis diyalog penceresi agllir.

x4 Control Tie Analysis

 Name Detail Dew Mim Dew E(m Dew Hgmg

qores ___________lHorz 3457 f29ss | |
& DRC Harz -3.1‘5? -2,955
O DRC Vert 0.562

Yert -0.562

Dengeleme islemi durdurulabilir , devam ettirilebilir, iptal edilebilir ya da degisiklik
yapildiktan sonra tekrar bastan baslatilabilir.

e Testi durdurmak icin Cancel tusuna basin.
e Degisiklik yapiimadan devam etmek isteniliyorsa Finish tusuna basilir.
e Kontrol noktasi secilip Reject (reddet) tusuna basilarak bu noktanin dengelemede

kontrol noktasi olarak kullanilmamasi saglanabilir ve Control Tie Analysis tekrar
baslatilir.

e Auto tusuna basilirsa maximum degeri gecen noktanin otomatik olarak teste
kullanilmayarak control tie analizine devam edilir.
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Dengelenmis Agin Kalitesini Degerlendirme

Dengelenmis agin kalitesi kalite kontrol testi ya da Tau kriter testi kullanilarak
degerlendirilebilir.

1- Process->Process Properties tiklanir.
2- Adjustment sekmesinde istenilen reddetme kriteri segilir.

12 Process properties

Adjustment | TS-Computstions | GPS+ PostProcess |
Confidence Level

68X

+ By Qually Contrel
™ Tau Critesion

W Control T Anabeen

DK Cancel

3- Ag dengelemesinde kotli gozlemler kullan ya da kullanma segenegi
mevcuttur.istenilen gézlem datasi Auto rejekt kolonu cift tiklanarak secim yapilabilir.
e Allowed : (izin ver) Ko6ti data otomatik olarak ag dengelemesinde kullaniimaz
e Not allowed: (izin verme) Kotli data ag dengelemesinde kullanilir.Gézlemler
icin tim dizeltme degerine sahip datalar bile kullanilir.

|h||:rt Alloweed 1'|

|r'-l|:-l: Al |

Agda dengelemede kullanilacak elemanlar Job configliration diyalog kutusunda GPS Obs
Precision / TS Obs Precision boliminde girilmis olan degere gore kabul ya da reddedilir.
(Job->Job configuiration->Quality control)

e By quality control secildiginde asagidaki elemanlarin diizeltme degeri gegerli is i¢in set
edilmis degerlerden bliylikse dengelemede kullanilmayacaktir.
0 GPS gozlemlerinin ve mesafelerinin , TS ag¢l Olgulerinin  dizlem
dengelemesinde kullanilacak tiim elemanlari.
0 GPS olcilerinin yikseklik ve TS in disey aci elemanlari.
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e Tau Criterion secildiginde ag elemanlarinin dengeleme sonucundaki Tau degeri Tau
kriterinden blyik olursa dengelemede kullanilmazlar.

0 GPS gozlemlerinin ve mesafelerinin , TS agl Olgllerinin  dizlem
dengelemesinde kullanilacak tiim elemanlari.
0 GPS olgulerinin yukseklik ve TS in dlsey agi elemanlari.

Dengeleme sona erdiginde Adjustment Result (dengeleme sonucu) penceresi gorintilenir.

& Adjustment Result

Control Tie Analysis: Success

Subnetwark 1,2, 3, ... [Horizantal Minimal Constraint + Vertical Minimal Caonstrant)

T Adjusted | Fixed | Weighted = Faquations (UsedRejected) = UWE
ype Points Points Points Bounds
GPS
Horz 4 1 i B/1 146 | [0.35.167]
Vert 4 1 0 /2 209 | [0.03224]

Rejected Observations

Name Type Residual N{m) Residual E{m) Residual Him)
34 GFS -0.004 0.006 0.039
23 GFS -0.024 -0.003 0.000
13 EPS -0.003 0.003 -0.029
Ok

Agda uygulanan tiim test sonuglari listelenir , listelenen bilgiler sunlardir;

e Kontrol Tie analizi sonucu testin basarili ya da basarisiz oldugu. Eger test sonucu

basarisiz ise yatay ve disey ag dengelemesinde sabit olarak kullanilmayacak kontrol
noktalari listelenir.

o~ Adjustment Result

Control Tie Analysis: Success

Subnetwork DRAS, WT_stat, DRBN, ..
(Horizantal Minimal Constraint + Vertical
£ b

0K
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Basaril test sonucu

o~ Adjustment Result

Control Tie Analysis: Unfixed Points
Type Dev N(m) Dev E(m) Dev H(m)
Both -20.269 -0.000 13.999

e Dengeleme tipi, serbest dengeleme, sadece yatay dengeleme , sadece diiseyde
dengeleme , yatayda ve diseyde tek bir kontrol noktasi ile dengeleme ya da yatayda
ve diseyde birden ¢ok kontrol noktasi ile dengeleme gibi.

Serbest dengeleme

Subnetwork 1,2, 3, .. {Horizontal Inner Constraint +%ertical Inner Constraint)

Yatay dengeleme

Subnetwork 1,2 3 .. (Horizontal Minimal Constraint)

Diisey dengeleme

oubnetwork 1,2, 3, . Wertical Minimal Constraint)

Yatayda ve diiseyde tek bir noktadan dengeleme

Subnetwork 1,2, 3, ... (Hatizontal Minimal Constraint + “ertical Minimal Caonstraint)

Yatayda ve diiseyde biden ¢cok noktadan dengeleme

oubnetwork 1,2 5, .. (Horizontal Constraint + Vertical Constraint)

e Yatay ve disey dengelenmis ag ayri ayri sunlari icerir. Dengelenmis noktalarin
miktarlari , sabit ve agirhikh noktalarin miktarlari , kullanilan gozlemlerin ve
dengelemede kullanilmayan gozlemlerin miktari , birim agirhgin hatalari (UWE) ve
UWE araliklari.
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e Reddedilen gozlemler ( ya da gozlem bilesenleri) eger uygulanabilir ise. Reddedilerek
son dengelemede kullanilmayan gozlem elemanlari bu tabloda kirmizi renkte
gorintilenir.

e Gegerliisicin girilmis degerden daha kot duyarlikta olan noktalar.

kA Adjustment Result

QC fail Points 5
Name StdDev N(m| StdDev E(mi| StdDev H{m|

WT_stal 0.000 0.000 0185
ET 0.000 0.000 0.164
DEE= 0.000 0.000 0.161

DREBN 0.000 0.000 0.161 =
DREM 0.000 0.000 0180
0T 0.000 0.00a0 0153
DRAS 0.000 0.000 0153
DRD 0.000 0.000 0153

b

<5 ! £/
OF.

GoOzlem degeri ile dengelenmis degeri arasindaki farki (residual) gegerli is te girilmis
degerden biyik olan gozlemler.

x4 Adjustment Result E|
QC fail Observations -
Name Type Residual N(m) Residual E{m) Residual H{im)
master BBGG-g2_8HOS PS5 -0.458 0.734 -0318 =
br
< | >
OF.

Dengelemeden sonra Harita ve liste pencereleri dengelenmis datayl icerecek sekilde
glincellenir.
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Dengeleme sonrasinda Liste penceresinde asagidaki kolonlar gériintilenir.

e Points sekmesinde noktalarin standart sapmalari
e TS Obs/GPS Obs sekmesinde gbzlem farklari

Skd Dew nim) | 5kd Dew & i(m) | Sod Dew Hz [m) | 5kd DEw U i) |
0.000 0,000 0,000 0.000
0,00z 0.00z 0.003 0,007
0.003 0.o0z 0.004 0.007
0.005% 0.004 0.007 001z
| adjustment Sta... Fes nim) | Res e (m) | Resu im)
adjusked -0.007 0,013 -0.009
Adjusted 0.007 0.003 -0. 006
Adjusked -0.002 -0.00z2 -0.002
Adjusked 0.oo2 0.000 -0.001
Adjusted -0.002 -0.000 0,001
Adjusted 0.00z2 -0.00z2 0.00z2

Dengeleme Raporunun Goriintiilenmesi

Topcon Tools da dengeleme sonrasinda dlclilen vektorlere ait 6zetler raporlanabilir.

Raporu goriintlilemek icin Report->Adjustment tusuna basilir.

GPS Observations [ !

Points

Quality Control
TS Observations

Report Confiqurakion... F9

Dengeleme raporu birden fazla pencerede dengeleme ile ilgili bilgileri gortintiler. Detayli

bilgiyi raporlar bélimiinde bulabilirsiniz.
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e Raporu bir dosya olarak kaydetmek icin Save as tusuna basilarak bir klasor secilir ve
save tusuna basilir.

e Raporu bir text editorli ya da baska bir yazi editoriine kopyalamak icin select all
tiklanir sonra copy tusuna basilir . Kopyalanacak editor programi acilir ve Paste
tusuna basilarak buraya yapistirilir.

e Raporu yazicidan yazdirmak icin Print tusuna basilir.

Ucggen Kapanmalari ve Raporunun Gériintiilenmesi

Ucgen kapanmalari kapal lcgeni olusturan bazlari kullanarak sonuc farkinin sifira yakin
olmasina bakar. Fark esik degeri ile karsilastirilir.(Yatay ve Disey tolerans ) Esik deger
asagidaki sekilde hesaplanir;

Horiz Tolerance = Horiz Tolerance abs +Horiz Tolerance rel « Length«10 o

Vert Tolerance = Vert Tolerance abs +Vert Tolerance rel = Lengths1 ¢°

Sonug farklari esik degeri asar ise raporda kirmizi renkte gérintilenir.

1- Raporu olusturmak icin Process->Loop closures tiklanir.Loop closures diyalog
penceresi gorintilenir.

Sl Report COGD Window  He :_H LDDp Closures
ZP5+ PostProcessing Fr
adjustment Fa Select static GPS observations
Localization. .. Shift+F& that form a loop. Press Finish

when pou are done, and loop

Loop Closures. .. Chrl+L

Process Properties,,.  Alk+Ckrl+P FRER

Cancel ‘ Options.. |

2- Ana ekranda (harita ekrani ya da GPS observation sekmesinde) liggen olusturan
Gozlemler segilir
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(U Map View

1| Pord From | Powt To | St Tew | Ouratnm [ Mt
a1 2 O 09 2000 140, CoDa:lS
L 3 04.09.2008 [42.., ODA:S
| 2 3 04.09.2000 14=.., 0D4:1S
1 4 e U000 140, CuOMa: 1S
« FEE - 04.00.2000 14:... O04:1%
LB | L] 04092000 14, OuDA:IS

3- Raporu goriintilemek ya da editlemek icin

a. Loop closures diyalog penceresinde Finish tusuna basilir. Ayri bir pencerede

Ucgen kapanma raporu agilir.
b. Rapro olusturmayi iptal etmek icin Cancel e basilir.

c. Standart rapor ayarini degistirmek isteniyor ise Options tusuna basilir. Bu

konu hakkinda detayli bilgi raporla ile ilgili b6limde bulunabilir.

Loop Closures
Loop dHz (m) = dU(m) = HortTolerance (m) | VertTelerance m) & dHz(ppm) = dU(ppm) | Length (m)
1-2{04.09.2001 14,07.43)
1-4{04,09.2001 1207-43) 0.0024 0.0007 D030t 00401 20187 8. 32 12.087
2.4(03 09 2001 140743}
2304 09 2001 1407 43)
2-4(04 09 2001 14.07°43) 00179 00535 ona 004 7358 88 Bid8 8 78283
3-4(04.09 2001 14.07.43)
Standart liggen kapanma raporu asagidaki bilgileri igerir ;

e Loop: Kapali licgeni olusturan kenarlar

e dHz ve dU : kapali loop a ait yatay ve diisey mutlak kapanma farklari.

e Horz Tolerance/Vert Tolerance (m) : Proses esnasinda kullanilan esik deger

e dHz(ppm), dU(ppm) l¢genin ppm hassasiyeti

e Lenght (m): Uggenin toplam kenar uzunlugu
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Gelismis Proses Modiilii Advanced Module for Processing

Gelismis modl aktif edildiginde Process Properties penceresinde GPS+ Post Processing de (i¢
sekme gorintilenir. General , Engine ve Troposphere dir.

12 Process propeities

12 Process properties

G= Process Genersl | Cngre  Tropeaphere
i Adustrent Goad & Goodman hopotphene model
12 75 Somprdiolons
= e W

Diay lgmrgmpeadure: "L} <0

EEEEEE— Pimitizs [mlla| 10132

£ I Hurmadiy: (%) [ Carcel

- iz Prooms General | tngre | Tropospbere | — 0= Precess Genersl  Emgine | Troposphers |
i Adustment Clevation Magk Iﬁ B I 7= Gdshrent Sane
I 15 Computations . 1T 15 Corputahies s
“ e =2 = = g ot [ -
Shane [ Seve Remmbuals
Mirumum Gursbon Sioplio
[Eod Tene - [ ngna Hode |Aeto -
M by teme{sec] '.w < ] Korwerodn:
b Enable contnuous | e [ noine Mods [aeto )

| Frapotphere parametens wv appied n o non H TK medes

oK | Larcel

Genel (General) sekmesi
General sekmesi asagidakilerin secilmesine imkan verir.

e Uydu yukseklik agisi

e Navigasyon sistemi (datalarda sadece GPS degerlendirilebilecegi gibi , GPS+GLONASS
datasi da degerlendirilebilir.)

e Arazideki minimum bekleme siresi igin iki segenek mevcuttur.

1- Auto topo segenegi secildiginde ;Topcon Tools gerekli es zamanh olgliye
prosese baslamak icin ihtiyac duyar. Zaman iki nokta arasindaki mesafeye ortak
izlenen uydu sayisina noktalardaki cihaz tiriine , cihazlarin tek ya da ¢ift frekansli
olmasina , sadece GPS ya da GPS+GLONASS datalarini toplama yeteneginde olup
olmamasina baghdir.

2- Fixed time segcildiginde Topcon Tools min obs.time alaninda girilen degere
gore es zamanl olclilerden gozlemleri olusturur.
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Engine Sekmesi

Bu sekmede kullanici istedigi proses modunu statik, dur-git, ya da kinematik proses olarak
secebilir. Her bir secenek i¢in asagidaki siklar mevcuttur.

e PP code only: Sadece pseudo-range 6lclisi dikkate alinir

e PP L1 only: Tek frekansh alicilar ile yapilan 6lglleri proses etmek igin kullanihr.

e PP L2 only: Sadece L2 élgllerini proses eder.

e PP L1&L2 : Cift frekans dlgllerini proses eder.(Cok kisa bazlarda onerilir)

e PP Llc: Uzun bazlarda toplanmis Cift frekans olcileri icin (>30km) iyonosferden
bagimsiz kombinasyonu formile edilir ve proses edilir ancak tamsayi sapmalari
dizeltilmez.

e PP L1-L2 :Uzun kenar kombinasyonlarinda kullanilir , genellikle uzun bazlarda
arastirma amach kullanilir

e PP L1+L2 :narrow-lane kombinasyonlarinda genellikle arastirma amach ¢éziimlerde
kullanihr

e L1&L2c : iyonosferden serbest her iki tamsayi bilinmezlik ¢cdziimiinde en giiglii ¢6ziim
motorudur. Cogunlukla g¢ift frekansh olgllerin degerlendirmesi igindir. Cogunlukla
30km altindaki bazlarda kullanilir , diisiik iyonosferik aktivitelerin oldugu durumlarda
bu mesafe 75km ye kadar arttirilabilir.

e VLBL : Cok wuzun bazlarin ¢6zimiinde kullanihr. iyonosfer ve troposfer
diizeltmelerinde (gl fazlar kullantlir.

e Wide Lane : L1-L2 modunun modifiye edilmis halidir. lyonosfer aktivitesinin L1&L2 ya
da L1&L2c de ¢ozilemeyecek kadar yiiksek oldugu durumlarda kullanilir.

e RTK Fixed : TPS alicilarindan RTK ¢6ziim motorunu kullanirak RTK ¢6ziim igin

e RTK L1 only : Sadece tek frekans datasini kullanarak RTK ¢6zim icin kullanilir.

e RTK Code only : Sadece pseudo-range RTK datasinin ¢6ziim{ icin kullanilir.

Kullanici her bir ¢6ziim igin AUTO segebilir.Bu segenek asagidaki statik dlgtler de kullanilr.

e Sadece tek frekans 6l¢li datasi var ise Auto secenegi L1 Only ye tekabiil eder.
e Eger proses edilen kenar 10km den kisa ise AUTO L1&L2 ye tekabiil eder.

e Kenar 10km ile 30km arasinda ise AUTO L1&L2c ye tekabil eder.

e 30km den 400km ye kadar AUTO Wide Lane secenegine tekablil eder.

e Son olarak kenar 400km den uzun ise AUTO VLBL secenegine tekabdl eder.

Topcon Tools ciftli fark artiklarini her bir statik GPS gozlemi icin kaydedebilir. Bunu yapmak
icin Save residual 1 aktif etmek gerekir.

Dur git ve Kinematik icin AUTO segenegi RTK Fixed segenegine tekabil eder.
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Troposphere Sekmesi

Topcon Tools bu penceredeki tanimlanan degerlere gore troposfer parametrelerini kullanir.

GPS Gozlemlerinin Pargalara boliinmesi
Gelismis modul herhangi bir gbzlemi bélmeye ve is deki iki gdzlemi birlestirmeye imkan verir.

1- Gozlemi bolmek igin Occupation sekmesinde bdlmek istenilen gozlem segilir ve
Mouse sag tus tiklandiginda ¢ikan mentden Split tusu secilir.

e Points GE GPS5 Occupations

Export ko Dewice. ..
Export. ..

Cuk Chrl+3

Copy ChrC
Delete Del

Disable &

Properties. ..

Ophions, .

2- Kullanici GPS occupation penceresinde datayi bélmek icin iki secenege sahiptir.

o~ Split GPSOccupation:
Name [BASEDB05a_SRMNK
Start Time  |05.08.2005 11:40:00 End Time  |05.08.2005 18:04:45

Duration  |6:24:45 NE poch [4615

Spitby: [N ~ | Spit Time 05082005 ~ | [145225 —

QK Cancel

e By time :zamana gore datayi bolme secenegidir. Default gelen deger toplam zamanin
yarisidir.istenilen zaman araligi secilip OK tusuna basildiginda data ikiye
bolliniir.Occupation sekmesi bir gézlem yerine bélinmus iki gdzlem gosterir.Pargalar
<orijinal isim>(Head-bas taraf) ve <orijinal isim>(tail-arka taraf) olarak isimlendirilir.

89



Bolmeden o6nce

.° Points @< GPS Occupations

| Start Time

| stop Time

| Duration

# BASEL BASEL

Bolmeden sonra

05.06.2005 11:40:00

05.08.2005 18:04:45

o7 Points @7 GPS Occupations

Icon | PointMame | A Original Name | Start Time Stop Time Duration
®  BASEl BASE1_Head 05.08.2005 11:40:00  05.08.2005 14:52:25
#, BASE1 BASE1_Tail 05.08.2005 14:52:25  05.08.2005 18:04:45 3:12:20

e By Hour (saate gore ) :Datayl saat olarak bolimlere ayirma seklidir.Ok tusuna
basildiginda bircok data olusur. Boliinme sonunda ilk bolim <orijinal isim>(Head-bas

taraf) vedevami <orijinal isim>(tail-n arka taraf) olarak isimlendirilir.

Bolmeden o6nce

e Points O? GPS Occupations |

1..| Point Name | Original Name | Start Time | stop Time Dur ation
@, BASE1 BASE1 05.08.2005 11:... 05.08.2005 18:... 6:24:45
Bolmeden sonra

° Points @ GPS Occupations I

1..| Paint Name |~ Original ... | Start Time | Stop Time | Duration I
# BASE1 BASE! Head 05.08.2005 11:40:00 05.08.2005 12:00:00 0:20:00
@, BASE1 BASE1 Tal 1  05.08.2005 12:00:00 05.08,2005 13:00:00 1:00:00
®_BASE1 BASEl Tal 2  05.08.2005 13:00:00 05.08.2005 14:00:00 1:00:00
®,_ BASE1 BASEl Tal 3  05.08.2005 14:00:00 05.08.2005 15:00:00  1:00:00
& BASE1 BASEl Tal 4  05.08.200S 15:00:00 05.08.2005 16:00:00 1:00:00
@, BASE1 BASE! Tal 5  05.08.2005 16:00:00 05.08.2005 17:00:00 1:00:00
®,_ BASE1 BASEl Tal 6  05.08.200517:00:00 05.08.2005 18:00:00 1:00:00
# BASE1 BASEl Tal 7  05.08.2005 18:00:00 05,08,2005 18:04:45  0:04:45

Datayi birlestirme icin asagidaki kurallar gecerlidir:

1- Sadece iki gozlem datasi bir seferde birlestirilebilir
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2- Ayni noktaya ait statik 6l¢li datasi birlestirilebilir

3- iki kinematik &lcii ayni dur git 6lciisiine ait ise birlestirilebilir.

4- Farkli kayit araligina sahip datalar birlestirilemez

5- Farkli anten parametrelerine ve /veya farkli anten seri numaralarina ait datalar
birlestirilemez

6- Farkl anten tipi kullanilmis datalar birlestirilemez

7- Farkh alici tipi kullanilmis 6lcller birlestirilemez

8- Tek frekansli 6l¢li datasi ile ¢ift frekansl 6l¢li datasi birlestirilemez

GPS sapmalarinin gériintileme /kaydetme GPS Residual

Save residual secenegi isaretlenir ise Topcon Tools GPS gozlemlerini proses sonucunda
sapmalari kaydederi Sapma grafigini goriintlilemek icin GPS Obs sekmesinde Mouse sag
tusu ile agilan menlde residual view secilerek gorintilenir.

" Points ]Q? GPS Occupations -:)? GPS Obs l

Icon | Point From | Paint To | Start Time
& _ Export to Device. .,
&, z Export...
®, 1
@ = Cut Chrl+%
®, > Copy Chrl+C
®, 1 Delete Dl
Disable

P>+ PostProcessing

W

Prosesde kullanilan hattin her iki ucunda ortak izlenen uydular icin Herbir ciftli farklar
hesaplanarak goriintilenir.

O Grafikteki X ekseni GPS gozlem siiresini
0 Y ekseni her iki es zamanli gbzleme ait taslyici dalga artiklarinin eksenidir.

Diyagram degisik renklerde goriintilenir.Her cizim kendi rengindedir.Lejand her bir gdzlem
grubuna ait renkleri géstermektedir.Yaninda ¢ek box sayesinde o renk gorlintisiu gorsel
grafik penceresinden acilip kapatilabilir. Bu grafikte arzu edilen durum sigrama grafiginin 0
etrafinda toplanmis olmasidir. 0 dan sigrama yapan uydu karsilastirma grafigi dalgalanma
yapan uyduyu gostermektedir. Bu uydunun datasinin ¢6ziimde kullanilip kullanilmayacaginin
karari bu grafik yardimi ile kolaylikla verilebilmektedir.
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e Ekranda uydu sigrama grafiginin Uzerine gelinerek Mouse sag tusu tiklandiginda
“show only....” Secilir ise sadece o iki uydunun sicrama grafigi gériintilenir.

III

e Sag tus tiklanarak “show all” segcilir ise tlim grafik gérintilenir.

e Sag tus tiklanarak Disable segilir ise o uyduya ait gézlem verisi kullaniimaz.

2% Residual View - 1-2 : 04.09.2001 13:03:58 M=1E3
Cucles
0.z —_
. | ' WM‘I\”{\M\\J\J& %“‘uﬂk NENE
] \I | ww‘/‘ N ¥ . A
] ’WW i et Show only G27-G28 L1 CIA i j| i
oL m MEL L T
] Disabls 527 v b uf I W
0 —]
-0.1 __
B | T T T T | LI LI T T T | T T T T LI LI | T LI T T T T T | T T T T T
G 04.08.2001 13:05:00 04.08,2001 13:06:00 04.08.2001 13:07:00 GPS Time
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Bu grafikte istenilir ise se¢im yapilarak sadece sigrama yapmis bolim disable edilerek bozuk
gozlem verisi ¢oziimde kullanilmamis olur.Tekrar aktif hale getirmek icin yine sag tus

tiklanarak enable secgilmesi yeterlidir.

= Residual View - 1-2 ; 04.09.2001 13:03:58

1-2 ; 04.09.2001 13:03.58

Show orly GIT-G2811 CJA
Show ol | | ! I

i1 | T Sow only GZTGRS L1 CIA
S Al

09,2001 120620

T T 7 r[r_F_F_"'—rr T
|

04092001 1 1:06:00

Ham datada sicrama grafigi sag tusla secildiginde goriintiilenen ilk uydu ismi disable ya da
enable yapilabilir. Es zamanli gdzlemin ikinci uydusu igin bu islem yapilmak isteniyor ise ;

1- Residual view penceresinde sag tus tiklanir ve Set GPS relative

2- Grafige ait isimlendirmedeki ilk uydu bu listeden segilir

3- Yeni ekranda disable denilerek bu uydu datasi ¢6zimde kullaniimamak Uzere

kapatiimis olur.
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2% Residual View - 1-2 : 04.09.2001 13:03:58
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Zoom 3
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. T RNl
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R LA I .\J.FW\J.;.\MH"MW b
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Uydu kapatma isleminden sonra GPS gozlemi tekrar proses edilir ve sonuglar tekrar irdelenir.

Dengeleme igin Gelismis Modiil

Gelismis moddl aktif edildiginde Process properties penceresinde Adjustment (dengeleme)
boliminde su gelismis segcenekler goriintilenir.

'3 Procaess propariies

= [i= Frocess Confiderce Level
= Talomputesons v 9G%
= PS5 PondProcema | 995
Flepction Citenon
" Dy Quaity Corol
© Tau Citenen
St Dinerraam |3|'.l
Aclpinboend | g

™ Inkeatdee Bhade Hepscion
0 duscenanc Diurder Flapettson

¥ vy Heprotod [haeeyobons
W Brabyse ldesic sl Ports

& Coniml Tie Snlynin

oK

Adpzt Dimension

3D
Auto
D
2D

i~ Adiustrnent Type -

|77 Interactive Blunder A ejection
[+ Automatic Blunder Fejection
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Dengelemenin kag boyutlu yapilacag segilir.

e 1D: Dengeleme sadece diisey dizlemde yapilir.

e 2D: Dengeleme sadece Yatay diizlemde yapilir

e 3D: Dengeleme yatay ve disey duzlemde yapilir

e AUTO: Dengeleme kontrol noktalarinin koordinatlarina ve kag¢ boyutlu
olduguna gore 1D,2D ya da 3D olarak otomatik olarak secilir ve gergeklestirilir.

Dengeleme tipinin secilmesi

e Automatic blunder rejection modu: otomatik kaba hata reddetme modu. Bu mode
dengelemeden Tay kriter ve By Quality control elemanlarini silmeye imkan verir.

Bu opsiyon advenced mod olmadan da default olarak kullanilir.

e Interactive Blunder Rejection modu: Bu moda ag kaba hataya sahipse ve Quality
kontrol ya da Tau kriterini gegememisse dengeleme islemi durdurulur ve kaba hatalar
ekranda gorintilenir.

&4 Horizontal Blunders, UWE = 389.29 @ &4 Horizontal Blunders, UWE = 389.29
Name Detail Residual | QC i Name Detai Tau [ Tau Crit, Morm Residual A
Wios)sTi#1-Paa#2o0 |HA |73t | (s sT1 4 1-P34#265 498,34 1192.72
V{95)5TI#1-PI4#265  HA 470.94 — (95)5T1#1-P34&290 sD 498,34 1192.60
V{95)5TI#1-P33#267  HA 295.72 — (95)ST1#1-5248268 5D 327.13 762.97
V{O5)STI#1-P33#292  HA 295.56 — (95)5T1#1-52484293 D 327.13 782.66
V{95)ST1#1-P30#291 HA& 294,75 W (95)5T1#1-P34#265 HA 303,67 746.61
V{SSISTI#I-PI0#266  HA 294.72 V (95)5T14#1-P34#230 HA 303.67 706.36
V{9E)STI#1-DI1#85  HA 158.95 V (95)5T14#1-P332267 HA 258,82 619.34
V{9B)ST1#1-D11#84 H 158.70 v W (95)ST14#1-P332292 HA 258,62 £19.54 v
< > < >
Reject ‘ Finish J Auto | Cancel ‘ Reject ‘ Finish ‘ Auto | Cancel ‘
. . . . g F i i, . . )
Rejection ‘By Quality Control Rejection by “Tay Criterion

Dengeleme islemi durdurulabilir , devam ettirilebilir , datada degisiklik yaptiktan sonra tekrar
gergeklestirilebilir

e Cancel tiklanarak agdaki hatalarin analiz edilmesi ve dengeleme iptal edilebilir
e Finish tiklanarak ag datasinda herhangi bir degisiklik gerceklestirmeden dengelemeye
devam edilmesi saglanabilir.

Reddedilecek degeri secin ve reject tusuna basin dengelemede bunu kullanmayacaktir.Tekrar
geri almak icin secip unreject tusuna basiniz.
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x4 Horizontal Blunders, UWE = 352.00

Mame | Detai J Residual j QC e

V(95)5T1#1-52304#284 Ha 1.04

WOEISTI#1-52304259 HA 1.04

V(OS)5T1#1-P33#267 He 591,55

B(95)5T1#1-P34#290 1547.51

< | @
Urreject hl Finizh Auto Cancel |

|

Auto tiklanirsa maximum hata degeri ya da taukriterini gecen degerler otomatik olarak

reddedilir.

e Kontrol noktasina agirlik atamak igin properties penceresinde Adjustment

sekmesinde arzu edilen agirlik degeri girilir.

& Properties : Point 1 E|rz|
String | CQusality control | Photo Mokes |
General |  Coordinates | caD Adjustment
Std Dew n [m) Im
Std Dev e [m) {0.07
Std Dev u [m) {0.04
Std Dev Hz [m] i0
Ok Cancel Apply

Agirhgr sifir olmayan kontrol noktalari agirlikli olarak dengelenir , ancak koordinatlari ve

standart sapmalari degistirilemez .
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RAPORLAR

Standart Raporlar

Raporlar datalarin ve islem sonuclarinin gorintiilenmesine imkan verir. Bu bolim Topcon
Tools standart raporlari ve 6zelliklerini agiklamaktadir.

e Raporu bir dosya olarak kaydetmek icin Save As tusuna basilir ve kaydedilmek
istenilen konum secilir ve dosya ismi yazilir.

e Raporu baska bir text editori icine kopyalamak icin 6rnegin MS Word Select All tusu
ile tiim rapor secilir Copy tusuna basilir. istenilen editér programi acilir ve paste
tusuna basilir.

e Raporu yazicidan almak i¢in Print tusuna basilir.

Dengeleme Raporu (Adjustment Report)

Dengeleme raporu almak i¢in Report ve Adjustment tiklanir.

3PS Obhservations !

Paoints
Quality Control
TS Observations

Feport Configuration... F2

Dengeleme raporu asagidaki alanlariigerir

e Proje Ozeti

e Dengeleme 0Ozeti

e Kullanilan GPS gozlemleri
e GPS gozlem farklari

e Kontrol Noktalari

e Dengelenmis noktalar
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Froject Summarny

Project name London Place tp
Sunvefee

Comment

Linissy Lrat Meters

Frofechon SPCHI-AlSKE [Zone 10)
Gaoid

Adjusiment Summary

Adusirmin tpe. Minkmal constran
Confidance level 86

A pogenion sandded bror of ueil veght 1384347
Mumber of agusted points:

Murbar of pland conrol it 1

Blunrier of heipht conital pors 4

Tetal turmbat of vecirs &
Murmier of used weciors. §

TS of Feecied wetors 2

Frigser_EBChal_SCID

master_SEGG-s1_4160 Fied 451 | 2883 | .rar 5168 0,04 0,007
mster_SBGG-51_BHDS Fixed Afza | 0478 | 1002 5212 0,000 1,004
Wl 0wl 4160 Fiaid DESA 1814 -1173 1. 0001 0004
40_80WN-52_8HDS Fiid 0002 | -1 | 1049 2003 0,001 0,002
1_4160-a3_ HDS Funsd -0EE4 -3558 111 5825 9,005 0,00

Mmaster_BEIEG-S0_BUVWE

mester_B8%G.a1_d4180

mister_SEBG0G~52_BHDS
f1_ACALS_g1R0
50_gsCnwdsd_sHDS
§1_aEsd_mHDOS 00 0010 0,083 AL FEpE ]

Aj

Cantral Peinte

7085618160 ' 123,513
7086519173 3055444 104 152,073
7085522174 3088444 176 152122
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GPS Gozlemleri Raporu (GPS Observations Report)

Raporu gorintilemek icin Reports->GPS Observations tiklanir.

Adjustment

Poinks !

Quality Control
15 Observations

Report Configuration,,, F9

Standart GPS Gozlem raporu asagidaki alanlari igerir.

e Proje Ozeti
e GPS Gozlemleri

master_8BGG-51_4160 Fixed 4,151 2589 -1.747 5,195 0,004 0,007
master_8BGG.s2_8HDS Froad -4 528 0878 «4.702 512 0003 0,004
s_S0W0-s1_4180 Fionad 0854 | 190 | 4173 2333 0,003 0,004
s0_S0W0-s2_8HOIS Fexad 0002 | Aper | o148 2,003 0001 0,002
51_4160ks2_BHDS Fioied 0 6554 3558 LI RES] 3625 0,005 0,008
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Nokta Raporu (Points Report)

Nokta raporu almak igin Report->Points tiklanir.

Adjustment

GPS Observations

Quality Contral l !

T5 Obsarvations

Report Configuration... F9

Gegerli nokta raporunda asagidaki bilgiler bulunmaktadir.

e Proje 6zeti

e Noktalar
File Edi Help
j 2 B =
Save &3.. Selectall Copy Frirt
TOPCON

Froject name: London Place.tip
SUrveyor.

Comment

Linear unt Meters

Frojection: SPC83-Alaska [Zone 10)
Geoid:

Project Summary

Points
Name Grid Northing {m) Grid Easting (m) Elevation (m) Code
master_8BGG 7065519750 S3068440,230 1538149 Dome
s0_BOWYD TOBS521,302 -3068444 853 153272
51 4160 TOGSO19 273 -306844%,104 192073
52 BHUS TOBSS22 774 -3065444 126 192,122
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Kalite Kontrol Raporu (Quality Control Report)

Kalite kontrol raporunu goéruintilemek igin Report->Quality Control tiklanir.

Adjustment
GPS Observations
Poinks

T3 Observations [!

Report Configuration... F9

Gegerli Kalite Kontrol raporunda asagidaki bilgiler bulunur;

e Proje 6zeti

e GPS gozlem kalitesi

e RTK gbzlem kalitesi

e Tekrarli gozlemler

e Kapanmayan lggenler

e Ozdes noktalar

e isimlendiriimemis GPS gbzlemleri

e Otomatik olarak reddedilen GPS gozlemleri
e Dengelenmis Nokta kalitesi
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Project Summary

GFE Obs Qualey

mosiw_SBGG-60_80W0 | 040001 130058 0,009 0.007 Fined
master BBGG-51 4180 | (40001130358 0,004 0.0aT Fiasd
master_SBGGA) 805 | 040901 130248 0,003 0.004 Fised
0_BOWEL51_4180 04 0001 130058 0,004 0.004 Fiusd
o0 BOWO.Ed E-0HS 04 0901 140358 000t 0002 Firea
¥i_418040 B80S 030001 1A0Y 52 0,005 0,008 Fimed
RTH Obs Qualy
Loop Closures
ﬁ‘;m l‘umgﬁ 1':'6'}55:;' 028 | 0po27 | 0O0262 | Doers D034 0.0856
4
11_ 418003 BHOS0M 08,01 1108 54)
AutoRejectsd GPS Obs
0 _B0W0.1_ 4D | D40901 130358 0022 LTk 0027
al_4bdoed DS | O40801 120058 -0 008 .10 L]0 n]
Adjusted Poirt Quaity
|m=mc- TORS518,750 ADBAL4D 230 15310 Dome
s0_BOWD TONS571.300 -3068444 53 153272
+1_4180 TOBSLIE.27T3 -30BE44S 104 152073
i1 805 TOE5T2 114 -3DBB444 128 192,172
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Lokalizasyon Raporu (Localization Report)

Lokalizasyon raporunu gorintiilemek icin Report->Localization tiklanir.

Repork

Adjuskrient

GRS Ohservations

Localizekion
Paints

Cuality Conkral
T5 Obseryations

Cerl41
Chrl+2
Chrl+3
_erl+4
ChFl+5
Ckrl+h

Report Configuration,.. F2

Gegerli lokalizasyon raporunda asagidaki bilgiler bulunur.

e Lokalizasyon raporu

e Lokalizasyon nokta reporu

‘1 localizatbon - lopcon look Heporl Viewss
Fie Edt Ieip

2 R B I
_mau... Sdect Al Copy Prirt
Localization Report

Rotation 0°01°18.6085

Scale 10001814546
Deflection Morth: 0°00'00.0614
Dallechon East 0°00'00.0923
Origin Lat 0°68'19.96363N
Origin Lon 0°388.61413E
Ongm ENHL 193.643

Cirigin Morthing 6176689400
Ongin Eashng 409235257
Cirigin Elevation: 181,408

Localization Paints Report

| WGS Point = Local Point Use NResidual (m)  EResidual(m) = HtResidual (m)

[ 54 S4LS Horizontal and Vertical 0054 0028 0,006 .

\ Vs { WSLS Honzonal eand Verical 0033 024 -0.002

l NS | nNaLS Horizontal and Vertical 0.006 0014 0.002

[ E2 | ens | Houonamavencd [ o015 0038 008 |
< >

103




Kullanici Tanimh Raporlar

Kullanici tanimli rapor olusturulacak raporda istenilen bilgileri almak yada almamaya imkan
verir. Kullanici tanimh rapor ayari yapmak i¢in Report->Report Configuration tiklanir.

Adjustment

GPS Observations
Points

Quality Conkral
TS Cbservations

Report Configuration... F9

Report Configiration diyalog kutusu asagidaki boliimleri icerir

e Reports alani gecerli raporlari gorintiiler.Rapor ismi tiklanarak o rapora ait elemanlar
goriintulenebilir.

e New report tusu yeni bir rapor olusturmak igin kullanihr.

e Delete report tusu var olan bir raporu siler

e Copy report as tusu var olan raporun bir kopyasini olusturmak icin kullanilir.Boylece
var olan bir raporda degisiklikler yapilarak yeni bir rapor olusturulur.

e Execute butonu segili olan raporu agik olan is dosyasinda ¢alistir ve raporu gorintiler.

e Available report templates alani raporun igerigini gorintiler.

e inculuded report items alani raporun igeriginin gériintiilendigi alandir.

e Move right (>>) move up, move down ve remove rapor iceriginin eklenmesi
cikartilmasi silinmesi ve siralamasinin asagi yada yukari degistirilmesi islemlerini
yapar.

e Options butonu segili elemanin ayarlarini gosterir

e Report format rapor formatini secme bolimuddr.
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& Report Configuration @E|

‘Reports:

' m ) T5 Observations
I‘:b] PS5 Observations

] paints

%] Quality Control

MNew report Delete repart Copy report as ... Execute
|&vallable report templates: Included report items:
| Move Up
Topcon Loga [tem A Topcon Logo Item
Identical Paoints Report = Project Summary
[ Cut Sheet Report Adjustment Summary Maove Down
| Mizhamed Autatopo Rovers Rep Used GPS Observations
Fepeated Observations: Report >z GFS Obzervation Residuals
Project Report = Contral Points Remove
Paint Summary B epart Adjusted Points
GPS Obs Report Adjustrment Report
Adustment Report i Options
Report format -
(& HTML

" Microsoft Word
[T Microsoft Excel

Clase

Rapor Ayarlarinin Editlenmesi
Rapor Kopyalama

Kopyalanmak istenilen rapor segilir Copy Reportas butonu tiklanir.Kopyalanmis raporun ismi
degistirilir.
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| Re port Configuration...

Reports;

Eﬁj adjuskment @ T3 Gbserrations

&) aPs Observations i vt

@ Painks 5PS Observations (2)

@ Qualicy Cenkraol

Hew report Delele report I Copy report az .. | Execute

Avail Meate:: Included report kems:

Copy report as .

hcon Logo ltem A Topzon Logo lem
ntica Poirks B eport Froject Summery
Shest Report GFS Observations

narmed Autatopo Fovers Fep
beated Observations Report

ject Feport

Fant Surmmam Feport
GPS Okbs Report
Adustrent Report b’

Hepart larma
& HTML

" Micrczoft 'Word
" Microsoft Excel

Close

Secili rapora yeni eleman eklemek icin available template bélimiinden arzu edilen segcilir ve

>> tusuna basilarak Included items bolimine aktarilmasi saglanir. Cikartilmak istenilen

eleman var ise included items bolimunde secilir ve Remove tusuna basilir.

Included items boéliiminde siralama degistirmek icin secim yapilip Move up tusu ile bir yukari
siraya move down tusu ile bir asagi tusa basilarak siralama degistirilebilir.

Execute tusuna basilarak olusturulmus rapor g¢ahistirilir.

Done tusu ile kaydedilir.

Availsble report templates: Included report items:

| Fepeated Observations Report A Topcon Logo ltem
Include | Project Report Praject Surmary

| Pioint Summary Report GPFS Dbservations
Items | GPS Obs Repart

| Adjustment Report »
| TS Obs Repart —E;E—

| Loop Closures. .
| Misnamed GPS Dcoupations Re
| Compare Point Report o
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E.fwailabfs report templates: Included repart items:

- Move U
Repeated Dbservations Repott A Topeon Logo ltem bt
Project Report : Project Summary
Remove p GPFS Dbservations Move Down
GPS Obs Report Loop Closures
Items Adjustment Report > | Compare Point Repart
TS Obs Repart Paint Summary Heport Femave
Loop Clasures... A
Misnamed GPS Dccupsations Re -
Compare Point Report i Optiors
Availlable report templates: Inchuded report items: Hoosli
Repeated Observations Feport A | Topcon Logo [tem it
- Pioject Repoit '
Order Point Summary Report | GPS Observations Move Down
Items GPS Obs Report | Loop Closures I b
Adustment Report >> | Compare Point Repart
TS Obs Report Remove
Loop Closures. .
Misnamed GPS Decupations Rey
Compare Point Repart v Options

Secilen Raporda Elemenlarin Editlenmesi

Eleman opsiyonlarinin degistiriimesi sadece secilmis olan rapora uygulanacaktir. Arzu edilen
rapor secilir , degistirilmek istenilen eleman included report items panelinden segcilir ve
Options tusuna basilir.

Segilen elemana bagli olarak degisik opsiyon pencereleri agilacaktir.

e Esnokta raporu ; isminde degisiklil yapip ok tiklanir.

&4 Options

|dentical Points Beporl

Cancel |

e Cut sheet report : arzu edilen elemanlar degistirilir.
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&4 Options

Name

-Selected columng

Ayailable columns Selected columns

Offset Code

Oftzet Direction LatitudesMorthing

Time Stamp Longitude'E asting
Cut(Fill) Ell height\Elevation

Fill Staked Latitudeh\MNarthing

Staked Longitude\E asting
Staked Ell heightsElevatio
dM

dE

dHt

Cut

e Tekrarl gézlemler (repeated observations): ismi degistirin ve baz icin rapor secilerek
OK tusuna basilir.

&4 Options
Mame

Repart Type

(Al vectors
(" GPS vectors only
_fﬁ TS vectors only

OK

e Proje Raporu: isim degistirilir ve Projekt template kisminda goriintiilenecek detaylar
goruntulenir, arzu edilen degisiklik yapilir ve OK tusuna basilir.
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k4 Options

Mame

Project Template

Project name: ZPROJECT NAMEZ
Project falder: 2PROJECT FOLDER %
Creation time: ZPROJECT CREATION
TIMEZ

Created by: 2PROJECT SURVEYORZ
Comment: 2PROJECT COMMEMT %
Linear urt: ZLINEAR UMNIT
Angular unit ZANGULAR UNIT:
Projection: ZPROJECTIOM

Datum: ZDATUMZ

Geoid: %GEDID?

0K

Cancel

e Nokta Ozet Raporu: isim editlenir ve goriintiilenmek istenilen secenekler secilebilir,

move up , move dovn tuslar ile gorintilenme siralari degistirilebilir ve OK tusuna

basilir.

%4 Options

Name

Selected columns

Paint Summary Beport

Grid Northing

Gnd Easting
Elesvation

Latitude
Longitude

Ell Height
Elevation [D aturn)
WE5E4 Latitude
WE584 Longitude
w/G584 Ell Height
Ground Morthing
Ground Easting
Control

(€

Select

+ Al

" Adjusted
" Control

Ok

Latitude\Morthing
LongitudehE asting
Ell height\Elevatian
> Code Move Up
<< Move Down |
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&4 Options
Name GPS Obs Repor

Selected columns
Awxailable columns

move up , move dovn tuslari ile goriintiilenme siralari degistirilebilir , hangi tip
noktalara parametrelerin uygulanacagi secilir ve OK tusuna basilir.

Selected columns

{€

Move Up

Mowve Down

Select
I Potential
[v PostProcessed
[ Adjusted
[ Buto-Rejected
[ Dizabled from Adjustrent
Method
[~ RTK Topo
[~ ATK AutaTopo
v PP Static
v PP Stop
[~ PP Kinematic
[~ PPGo

oK

Cancel |

detaylar gorintilenir, arzu edilen degisiklik yapilir ve OK tusuna basilir.

GPS gézlem Raporu: isim editlenir ve gériintiilenmek istenilen secenekler segilebilir,

Dengeleme Raporu: isim degistirilir ve Adjustment template kisminda gériintiilenecek
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&4 opt
4 Uptions
M ame |.-ﬁ-.|:|iustment Repart

Components Count; ZCOMPONERTS COUNT %

Component Fonts: ZCOMPOMENT HNAME=

Adjustment type: ZADJUSTMENT TYPEX

Conhdence level ZCOMFDEMNCE LEVEL: %

Mumber of adjusted points ZMUMEER OF ADJUSTED POINTS3

Mumber of plare control points: ZMUMBER OF PLANE COMTROL POINTS
Murber of uged GPS veciors: EMUMBER OF USED GPSVECTORS
Mumber of S0 condbions: HUMBER OF S0 COMDITIONS %

Mumber of HA condiions: ZHUMBER OF HA COMDITIONS %

Mumber of rejected GPG vectos by plane: ZMUMBER OF REJECTED GFS
WECTORS BY PLAME X

Mumber of rejected 50 conditions: SMUMBER OF REJECTED 5D
COMDITIONSE

Mumber of rejected HA conditions: SMUMBER OF REJECTED HaA
COMDITIONSE

A pastenan standard arror of wnit weight for plare adjustment: %24 POSTERIORI
STAMDARD ERROR OF UMIT WEIGHT FOR PLAME ADJUSTMENT %
Muriber of height control pointz %MUMBER OF HEIGHT COMTROL POIMT S

ok Cancel

Adjugtment Template

e Ucgen Kapanmalari:isim degistirilir, raporlanacak Uggenler secilir tamami ya da
sadece kapanmayan Uli¢cgenler, gorintiilenmek istenilen secenekler secilebilir, move
up , move dovn tuslari ile goriintiilenme siralari degistirilebilir.

%4 Options
Name |Loop Closures

Report Loops

Al
(* Failed

Selected columng

Available columns Selected columns

dM dHz

dE dlJ

dHz relative Horz Tolerance
dU relative Yert Tolerance
dHz. PPM

dl, PP
Length

Maove Down
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e isimsiz gdzlemler raporu: isim editlenir ve OK tusuna basilir.

&4 Options

Mizhamed GPS Oocu

e Noktalar karsilastirma: isim editlenir ve gériintilenmek istenilen secenekler
secilebilir, move up , move dovn tuslari ile goriintlilenme siralari degistirilebilir ,
hangi tip noktalara parametrelerin uygulanacagi secilir ve OK tusuna basilir

4 Options E

Mame Compare Point Bepor
Selected columns
Available columns Selected colurnns

Chrl Flag dh

Latitude\Northing dE |
Longitude\E asting >> dH Move Up

Ell height'\E levation P

Adjusted Latitude\Morthing
Adjusted LongitudeE asting

Adjusted Ell height\Elevatiol

£< Move Down |
Ok Cancel Aol |

Yeni Bir Rapor Ayari Olusturma

1. Report configuration diyalog penceresinde New Report tusu tiklanir.Report

penceresinde User report ismi olusur.
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& Report Configuration. ..

Repartz:

] adpstment [E] 75 chservations
[tz] zps Observations 53]

Itz] Foints [%
] ualty Control

D elete repari Copy report as .

Ineluded 1epaoit iteme:
" -
Wt | [koiopo Fovsrs Aep
Ibservaions Repart b

Praoject Hepomt
Font Summaw Fepoit
GFS Obs Hepot
Adustment Bepart b

Cle=e

3- Arzu edilen secenekler Available report templates listesinden secilir ve >> tusuna
basilarak Included report items penceresine aktarilr.

Aualable repoirt kemplates: [eluged epart iteme:

Repeated Observations Reparl A Topcon Loga [bem
Project A epot Project Sunmany
Pont Suremany Fepart GPS Obzervations

GRS bz A epmt
Adpstment Repart >
T5 Obz Hﬁurt

tizhamad GPS 0 coupstions Fe
Comparz Point Repart b

4- Move up ve move down tuslari ile istenilen siralama diizeni yapilir.

5- Editlenmek istenen eleman segilerek options tusu tiklanir.

6- Olusturulan raporu calistirmak icin Execute tusu tiklanir, Done tusu tiklanarak
olusturulan rapor kaydedilir.
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Topcon Tools da Kullanilan Semboller

Topcon Tools da eger data Kalite kontrol testini gecemeyen degerler icin semboller
kirmizi renktedir.Neden testi gecemedigini 6grenmek istiyorsaniz o dataya ait sag
tus ile acilan Properties penceresindeki Quality control sekmesinden gorilebilir.

Point sekmesinde bulunan semboller

Semboller Agiklama
Kalite kontrol testi
gegen
(mavi)/ge¢meyen
(kirmizi)

Manuel nokta.(Edit->add->point menisi kullanilarak eklenmis nokta)

Bilinmeyen nokta (koordinat dosyasindan kontrol noktasi olmayan

e nokta is dosyasinin igine alindi)

a !l A Yatayda ve duseyde fixlenmis kontrol noktasi
&40 Yatayda fixlenmis kontrol noktasi
O / 0 Diseyde fixlenmis kontrol noktasi

'[ti' / Aplikasyon noktasi

_$_ J $ Tasarim noktasi

COGO ile koordinati hesaplanmis nokta

# / w Dengelenmis nokta

Total station (TS)istasyonu

¢ / * TS noktasi
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TS bakilan nokta

RTK sabit noktasi

o

RTK ile 6lg¢lilmis nokta

RTK otomatik alim ile 6lctilmis nokta

Statik 6lcl noktasi

Dur-git statik 6l¢l noktasi

o o @ @

Kinematik 6l¢li noktasi

Celik serit metre 6lc¢li noktasi

GPS ofset noktasi

PTL (hatta nokta) ofset noktasi

Nivelman Traverse noktasi

Nivelman noktasi

(statik ve kinematik) proses edilmemis GPS statik 6lci noktalari

Taranmig nokta

L
Y

Event noktasi

Resim 6lgme noktasi
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Asagidaki tablo nokta semboll kirmizi olmasi durumunda properties penceresinde Quality

control sekmesinde yazan agiklamalarin ne anlama geldigi bulunmaktadir.

QC sekmesindeki Mesaj

Mesajin Agiklamasi

Control point is not
linked with network

Kontrol noktasi dengelemede kullanilmamaktadir.

This point is very close
to point “name” .They
are probably identical.

Bu noktalar arasindaki mesafe Quality Control sekmesinde
girilen degerden kigik.Muhtemelen bu noktalar ayni es nokta.

Failed to match the
desired precision

Quality Control point precision sekmesinde bulunan nokta
duyarligindan yatay ve disey duyarlik kéti degerde

Some GPS occupations
autonomous  positions
are too far away from
point. They are probably
misnamed

Bu nokta icin birden fazla ol¢li var ve gézlem sonu koordinatlari
arasinda 30metre den daha fazla mesafe var. Bu gozlem ismi
degistirilmelidir.

Control Tie test failed

Sabit nokta koordinatlari ile dengeleme sonucunda hesaplanan
koordinatlar arasindaki  fark Job->Job  configuration-
>QualityContro->Point precision boliminde girilen degerden
kot
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GPS Occupation sekmesi sembolleri

Semboller Acgiklama
Kalite kontrol testi
gecen
(mavi)/ge¢meyen
(kirmizi)
& RTK sabit 6l¢li datasi
&
e /O RTK olgusi
* &
&/ @,L Otomatik moda alinmis RTK 6l¢lsii
A
@ 'Q GPS statik 6lci sabit nokta olglisi
e /@ Statik GPS dur-git 6l¢lsu
=% Kinematik statik olglsi

Asagidaki tablo nokta semboll kirmizi olmasi durumunda properties penceresinde Quality
control sekmesinde yazan agiklamalarin ne anlama geldigi bulunmaktadir.

QC sekmesindeki Mesaj Mesajin Agiklamasi

No ephemeris Sadece goOzlem datasi mevcut.Kullanici navigasyon dosyasi
download edip kullanmak zorundadir.

Some GPS occupations | Bu nokta icin birden fazla ol¢li var ve gézlem sonu koordinatlari
autonomous  positions | arasinda 30metre den daha fazla mesafe var. Bu gozlem ismi
are too far away from | degistiriimelidir.

point. They are probably
misnamed
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